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1. Introduction 

1.1 Welcome 

E-Scape is a computer software system, that allows people to compose and play music unaided, 

whatever their physical ability or musical knowledge. 

E-Scape allows you to compose and perform music using, at the minimum, a single switch, but is very 

flexible in the way it can be controlled: you can use 1-4 switches, the computer keyboard, trackball, 

joystick or mouse, or musical (MIDI) equipment (for example hitting keys or drum pads, or moving 

with a Soundbeam or MIDIcreator). 

Musical choices and options are presented to you as E-Scape guides you through the composition 

process. Notes can be selected, entered one by one into the score and then edited.  To perform your 

composition, there are various options that allow you to play your music live using switches or MIDI 

equipment. 

MIDI files can be loaded in and edited, or exported to use in other music software, for example to print 

out a manuscript score.  Any piece of music can then be played back, or can be performed live in 

several ways - again with a single switch, if necessary. 

Visually E-Scape presents a single, large clear screen. The colour and sizes of some items can also be 

altered, and menus can also speak automatically to aid visually impaired users or non-readers. The 

degree of choice and flexibility provided can be altered to suit different users. 

E-Scape can serve a breadth of users, ranging from the beginner with little or no musical knowledge to 

advanced composers working individually or within workshop group. It is possible to use E-Scape to 

learn about music and to compose and perform alongside other instruments 

1.2 Using E-Scape - an overview 

E-Scape has a single 'Score' window, which can display one or more tracks. There is initially only a 

single track (musical ‘part’) shown, and you can add more tracks as you want later. For each track, you 

will first be asked to choose an instrument sound - this is done by auditioning (or listening to) each 

available sound in turn.  

If you are using switches (or <Space> and <Enter> on the keyboard) to operate E-Scape then you will 

be using a series of menus that pop up in the middle of the screen. There are also more conventional 

mouse operated menus at the top of the window - for example a non-disabled user may use these to set 

up the system for a disabled player (or a class of children) to perform.   

Other disabled users can choose to operate the entire system themselves, controlled for example via a 

single switch or a MIDI instrument. 

Using switches or keyboard, you can make a choice of what to do from a series of menus, which pop up, 

along with a prompt or question. For example you can play, enter notes, copy them, or change their 

length, position, pitch and volume.  

Other menus let you do such things as alter settings and control parameters, zoom in and out, save or 

load scores, perform the score live, add more tracks etc. 
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1.3 For the impatient 

If your PC is set up correctly for MIDI, E-Scape is running, and you are the adventurous type, then you 

may want to jump in straight away. If so, you could go to Chapter 5 and have a tour round. If you are a 

switch user, you may first need to look at sections 2.2.7, 3.2 and 4.2.1 before jumping in. 

To fully understand all the aspects of operating E-Scape, you should then come back and read from 

here: 

• Chapter 2 describes how to install E-Scape, and what other items (software and hardware) 

you might need to run it on your PC.  

• Chapter 3 describes how to set up your PC to operate E-Scape. 

• Chapter 4 describes all the ways of operating E-Scape - using menus, keyboard, switches, 

mouse, or MIDI. 

1.4 Other sources of information and help  

There is useful information about E-Scape in the 'Instruments' section of www.DrakeOnline.org, 

including: 

- 'Get Into': an animated introduction. 

- Music (mp3) created by disabled musicians in London using E-Scape, some with only one or two 

switches. 

- Video of a young disabled musician who is has passed several graded exams with Trinity 

College London, using E-Scape with 3 switches. . 

In the Technology section of www.DrakeMusicProject.com ('Technology Articles' link), there is 

information about and pictures of musicians in London who are composing using E-Scape. Some 

operate via keyboard, and others are using one or two switches.  

The direct link is www.drakemusicproject.com/main/technology/55/LonComp9.cfm. 

 

A guide to using Windows in general via the keyboard can be downloaded from:  

www-users.cs.york.ac.uk/~alistair/MouselessManual.pdf (576k download). 
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2. Installation & Requirements 

2.1 Installation procedure 

2.1.1 Installing files from the CD-ROM 

Open the CD from your Windows desktop, and open the file 'Install E-Scape 2.x', and follow the 

prompts. After installation is complete, you will be given the option to start up E-Scape immediately. If 

you have the full version, you will be asked for your installation password. If you don’t have it, you can 

still proceed, and work in 'trial' mode - everything works except the ability to save files. 

2.1.2 Start menu items 

In the Window 'Start' menu: select Programs, then E-Scape. This sub-menu will initially have a single 

item 'E-Scape 2.x'. 

If you later install any updated versions these will also be available within the 'E-Scape' sub-menu. 

2.2 Computer requirements 

E-Scape is modest in its PC requirements, and any PC bought since 2000 - even the most basic spec 

- should be able to run it. More details are given below. 

2.2.1 PC Hardware – PC 

P200 (i.e. Pentium processor, 200Mhz speed) minimum recommended, although E-Scape will work 

on slower machines, given sufficient memory. 

2.2.2 PC operating system 

E-Scape runs under all versions of MS Windows from Windows 95 onwards (i.e. 95, 98, ME, 2000, 

XP, Vista). 

2.2.3 PC memory (RAM) 

For E-Scape to run at a reasonable speed, you need approximately 24MB free memory, plus 

whatever is needed for Windows, plus any speech reader you want to use. For example, using 

Windows 98, total 64MB is fine, but 32MB is too slow. 

2.2.4 PC Hard Disk Size 

20MB free disk space required. 

2.2.5 Hard Disk Speed 

Any. Once launched, E-Scape makes no demands on the hard drive. 
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2.2.6 Audio Hardware and MIDI Instruments 

E-Scape uses MIDI instruments, and can be used with any MIDI device that works with Windows.  

E-Scape simply uses whichever MIDI device is selected by Windows (see 3.1.1). MIDI instruments 

can be provided in two main ways: 

(a) within the PC itself: 

i. Software instruments built in to Windows. 

ii. 'Soft-synth' applications. 

iii. MIDI Instruments within a PC soundcard. 

(b) through an external MIDI device (synthesiser or sampler) connected to PC via MIDI, either via: 

i.  the MIDI port of a PC soundcard. 

ii. an external MIDI interface. 

See 3.1.3 for examples of hardware set-ups. 

(a) Instruments within the PC 

Sound is generated by devices within the PC case itself, so powered speakers etc should be 

connected to the appropriate socket on the PC – e.g. a laptop PC's audio / headphone socket, or the 

audio outputs of any soundcard fitted PC. See 3.1.3(a) for examples. 

i. Windows software instruments 

Almost all PCs now have MIDI instruments built into Windows itself. This means that any music 

software, such as E-Scape, can play back music without any additional hardware. These sounds are 

adequate for basic music making, but for an advanced user may prove restricting in range and quality.  

ii. 'Soft synths' 

Far more sophisticated and high quality sounds can be provided, again within the PC itself, using a 

wide variety of 'software synthesisers' or samplers, which can operate with MIDI data routed internally 

from E-Scape. These are quite straightforward to use as far as E-Scape is concerned - as stated 

earlier, it simply plays whichever MIDI instrument is set in Windows (see 3.1.1). 

However, if you are planning to use MIDI input to E-Scape as well as using software synthesisers, 

then various issues can arise - this is more an area for experts, and you don't need to go there to be 

able to use E-Scape perfectly acceptably. 

iii. PC soundcard instruments 

Any PC 'Soundcard' which provides on-board MIDI instruments (which is most of them) can be used 

by E-Scape.  You will just need to connect powered speakers to the audio output socket of the 

soundcard. 

(b) External MIDI devices 

More flexibility, reliability, and simplicity, and certainly better quality than built-in sounds (a.i. above) 

can be gained from using an external MIDI device (e.g. a sound module or keyboard). In this case, 

you will then need to connect speakers to the audio output socket of the external device.  

You can also optionally connect a MIDI input to a MIDI controller device (e.g. keyboard, drum pads, 

MIDIcreator or Soundbeam) to provide control and musical input into E-Scape. 

Each device is attached by a MIDI cable, which is connected to the PC via (i) PC Soundcard, or (ii) 

external MIDI interface: 
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i. Connect via Soundcard MIDI interface 

Most soundcards provide a MIDI output port, and an external MIDI sound module can be attached via 

a MIDI connection, usually using a special lead which attaches to the Soundcard which has one or 

two standard MIDI (5 pin DIN) plugs on the other end which plug into your MIDI device. 

ii. Connect via external MIDI interface  

An external MIDI interface1 can also be connected to the PC (via USB, parallel or serial ports), and 

external MIDI devices are then plugged into this via MIDI leads. See 3.1.3 for example set-ups. 

This is most useful for laptop PCs - most include basic built-in MIDI instruments as standard, but have 

no provision for the PC soundcards described above (although more advanced solutions via PC cards 

are available). 

2.2.7 Switch interfaces 

Any switch interface which emulates a keyboard can be used with E-Scape.  These do not need any 

software drivers to work, and simply plug into the PC where the keyboard does, using PS/2 or USB 

connections.  

* Please note that E-Scape does NOT support serial port interfaces. 

The switch interface needs to be set up to output key presses '1' and '2' to operate menus (or just '1' 

for single switch operation), and most interfaces have this as standard.  

The '3' key can also be used to give additional control of menu scrolling, and performing. Where 

available, additional switches can also be used to press keyboard shortcuts, e.g. to play, open 

specific menus, transpose, select notes, select tracks etc. 

NB. If you have a laptop PC, check which connections it has as there are some that do not have PS/2 

sockets. 

(a) Examples of switch interfaces 

Manufacturer Product PC 

Connection 

No. of  

Switches 

Approx. cost  

(ex VAT) 

Sensory JoyCable USB 2 £60 

Sensory JoyBox (*1) USB 12 £100 

Crick Switch Box USB 4 £100 

Inclusive SwITchBox PS2 8 £70 

Inclusive SwITchBoard  (*1,2) PS2 16 £90 

Don Johnston Switch Interface Pro (*1) PS2 5 £69 

Don Johnston Switch Interface Pro 5 (*1) USB 5 £75 

Notes: 

*1. These have been specifically tested to work with E-Scape. Others should also work. 

*2 This is a PC keyboard with additional switch sockets. A keyguard is also available to fit it. 

                                                
1
  These MIDI interfaces can also be used with desktop PCs, but as almost all PCs already have a Soundcard 

with in-built MIDI interface, they would be superfluous. 
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(b) Switch interface suppliers: 

Sensory Software: www.sensorysoftware.com (follow 'Hardware' then 'Switch connectors' links) 

Don Johnston: www.donjohnston.com (follow 'Products, then 'Access' links) 

Inclusive Technology: www.inclusive.co.uk (follow 'Catalogue' then 'access devices' links) 

QED: www.qedltd.com (follow 'Interface devices' link) 

NB. Most of the above suppliers sell each other's products as well as their own. 

2.2.8 Speech synthesiser 

 

To hear speech output from menus and alert boxes etc., you can use any PC speech synthesiser 

which can be set to read the Windows clipboard automatically.  

Recommended synthesiser packages are 'Windbag' and 'Reader', both are available on CD from 

Sensory Software International Ltd. The CD will install all necessary speech components. 

Programs are also available as downloads from their website (www.SensorySoftware.com). (Note: 

Speech applications may require a speech engine to be installed in Windows 98 – see below).  

'Reader' is free, and a small download. Windbag is a larger programme, but has many useful 

features, and a free demo version is available so you can assess it before buying. 

System Requirements - Windows 98 

If you find that speech is not working, you may need to install further software. There are two 

components that need to be installed: 

1. Speech Application for PC (SAPI or ‘spchapi’ version 4.0) 

2. Microsoft text-to-speech (MSTTS)  

 

To check whether they are already present: 

SPCHAPI – use Go to Start Menu -> Find. Search for ‘spchapi’. There should be at least 2 files 

reported in the results, including ‘SPCHAPI.INF’. 

MSTTS – Go to Start Menu -> Programs and open the folder. There should be a sub-folder called 

’MSTTS’ or ‘MSTTSL’ 

If they are not present:  

download ‘spchapi.exe’ (Version 4.0) via www.SensorySoftware.com, or from: 

http://www.microsoft.com/speech/download/old/sdk40a.asp (848k) 

Download ‘Microsoft Text-To-Speech’ from: 

http://www.pcworld.com/downloads/browse/0,cat,1479,sortIdx,1,00.asp (7.5 Mb) 

and follow the on-screen instructions. 

 

See 3.3 for details on setting up these speech programs with E-Scape. 
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3. Setting up your PC for using E-Scape 

3.1 Setting up MIDI 

If you have a straightforward 'standard' PC system, then E-Scape will usually work straight away 'out 

of the box' with MIDI instruments. If you are using a more sophisticated system, then you may need to 

change some MIDI settings within Windows, and/or E-Scape. In this section, we also show some 

typical layouts and connections of the PC with MIDI devices for using E-Scape. 

3.1.1 PC MIDI Settings  

As stated earlier, E-Scape simply uses whatever MIDI instruments are selected for Windows. The 

only setting you need to make is to tell Windows which MIDI device (whether internal or external) you 

want to use. This is done by a Windows control panel: 

(a) Windows 98 -' Multimedia' control panel 

In Windows 98 we use the 'Multimedia' control panel. First, you need to make sure E-Scape is not 

running (if it is, then Quit, e.g. Ctrl-Q), as Windows won’t let you change the MIDI output while an 

application is using it. 

 

 

 

(a) In Windows 98, open the ''Multimedia' Control 

panel (from Start menu -> Settings-> 'Control 

Panel'). 

(b) Select the 3rd 'MIDI' tab 

(c) In the 'Single instrument' menu, select which 

output you want to use. If you have installed any 

soundcards or MIDI interfaces they will be in this list. 

If you are using a MIDI interface or soundcard for 

MIDI input into the PC, then this will always be fed 

into E-Scape, although in some cases (more 

advanced soundcards) there may be settings to 

make in a set-up application for your soundcard or 

interface – please refer to manufacturer’s 

instructions.  

 

 

 

 

 

 

 

 

 



E-Scape: Getting Started Guide   © Inclusive Music, 2008                                                            10

(b) Windows XP - 'Sounds and Audio Devices Properties' control panel 

In Windows XP we use the ‘Sounds and Audio 

devices properties‘ control panel. First, you need to 

make sure E-Scape is not running (if it is, then Quit, 

E.g. Ctrl-Q), as Windows won’t let you change the 

MIDI output while an application is using it. 

(a) In Windows XP, open the 'Sounds and Audio 

Devices Properties' Control panel (from Start menu -

> Control Panel). 

(b) Select the 3rd 'AUDIO' tab 

(c) In the MIDI music playback section at the 

bottom, select which output you want to use. If you 

have installed any soundcards or MIDI interfaces 

they will be in this list. 

If you are using a MIDI interface or soundcard for 

MIDI input into the PC, then this will always be fed 

into E-Scape, although in some cases (more 

advanced soundcards) there may be settings to 

make in a set-up application for your soundcard or 

interface – please refer to manufacturer’s 

instructions.  

 

(c) Windows ME – Sounds and Multimedia 

Properties control panel 

In Windows ME we use the ‘Sounds and Multimedia 

properties‘ control panel. First, you need to make 

sure E-Scape is not running (if it is, then Quit, E.g. 

Ctrl-Q), as Windows won’t let you change the MIDI 

output while an application is using it. 

 

(a) In Windows ME, open the 'Sounds and 

Multimedia properties' Control panel (from Start 

menu -> Settings-> Control Panel). 

(b) Select the 2nd  'AUDIO' tab 

(c) In the MIDI music playback section at the 

bottom, select which output you want to use. If you 

have installed any soundcards or MIDI interfaces 

they will be in this list. 

If you are using a MIDI interface or soundcard for 

MIDI input into the PC, then this will always be fed 

into E-Scape, although in some cases (more 

advanced soundcards) there may be settings to make in a set-up application for your soundcard or 

interface – please refer to manufacturer’s instructions.  
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3.1.2 Settings for MIDI devices and E-Scape 

If the synthesiser you are using is a 'GM' device, then it will work with E-Scape with its default 

settings. If you are using a more complex MIDI device (whether external or internal, hardware- or 

software-based - see 2.2.6), then there are two areas where you may need to set up MIDI:  

(a) Matching E-Scape's output channels with the input channels of the MIDI device  

By default E-Scape is outputting on all 16 channels, but allocates these to tracks automatically 

starting with the lowest, i.e. Channel 1. You can usually set which input channels are used by your 

MIDI device, or you can set E-Scape to use particular channels - the important thing is that you set 

MIDI channels to be the same for E-Scape and the device is it controlling. 

(b) Setting how MIDI instruments (programs) are controlled  

By default E-Scape sends MIDI program change messages, which then select the correct instruments 

in the MIDI device. However, if your device does not allow this, or if you prefer to set these up on your 

device manually, then you can set E-Scape not to send these messages (turn ‘Send Program 

Changes’ off in the MIDI Set-up menu of the Settings Window). 

3.1.3 Typical configurations of PC and MIDI devices for using E-Scape 

(a) Using PC internal sounds 

a.i. PC (e.g. laptop) using internal MIDI instrument sounds (or 

'softsynth').  

Connection:  

- Audio output of PC (e.g. headphone socket) -> external speakers.  

a.ii. Desktop PC using Soundcard for MIDI instrument sounds (or 

output routed from softsynth).  

 

    Connection:  

  - Audio output of Soundcard -> external speakers. 

(b) Using external MIDI module 

b.i. PC (inc. laptop) with external MIDI interface: 

An external 'MIDI interface' connects to the PC via serial, parallel or USB. The MIDI interface then 

connects (via MIDI cable) to an external MIDI sound module, which provides the instrument sounds.   

 

 

Connections:  

- PC-> MIDI interface (via USB, serial etc).  

- MIDI 'out' of MIDI interface -> MIDI 'in' of Module.  

- Audio output of Module -> external speakers. 
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b.ii.  Desktop PC with built in Soundcard MIDI output: 

The soundcard's MIDI output connects to an external MIDI sound module, which then provides the 

sounds.   

 

Connections:  

- PC soundcard MIDI 'out' -> MIDI 'in' of module.  

- Audio output of module -> external speakers. 

 

 

 

(c) Using E-Scape with a MIDI keyboard 

A MIDI keyboard can also be used. The PC can either have an external MIDI Interface (as bi) or 

soundcard with MIDI (as bii). 

c.i. Using a MIDI keyboard (synthesiser or sampler) instead of 

a MIDI module, as (b) above. 

Connections:  

- MIDI 'out' of Keyboard -> MIDI 'in' of MIDI Interface or 
Soundcard.  

- MIDI 'out' of MIDI Interface or Soundcard -> MIDI 'in' of 
Keyboard. 

- Audio output of Keyboard -> external speakers. 

You will also need to set the keyboard to 'Local OFF'. 

 

 

c.ii  Using a MIDI 'master' keyboard – i.e. with no built in sounds. 

This connects to the MIDI Interface or Soundcard, as well as the sound Module (as b). 

 

 

. 

Connections:  

- MIDI out' of Keyboard -> MIDI 'in' of MIDI Interface or 
Soundcard.  

- MIDI 'out' of MIDI Interface or Soundcard -> MIDI 'in' of 
Module. 

- Audio output of module -> external speakers. 
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(d) Using E-Scape as one instrument with MIDI module or keyboard 

Using a MIDI 'Merge' box, a MIDI sound module or keyboard can be shared between a number of 

players, each playing a MIDI 'controller', e.g. a MIDI keyboard, Soundbeam, MIDIcreator, drum pads 

or PC running E-Scape. E-Scape is then operating as one 'MIDI controller' along with others. 

 

Connections:  

- MIDI 'out' from the PC MIDI interface or Soundcard -> MIDI 'in' on merge box.  

- MIDI 'out' of Merge box -> MIDI 'in' on module or keyboard.  

- Audio output of module or keyboard -> external speakers. 

You will need to set up which MIDI channels are used by each MIDI 'controller' and by E-Scape, so 

they do not conflict. 

 

 

 

 

 

 

 

 

 

(e) Using E-Scape as the master instrument with MIDI module and multiple controllers 

You can also use a MIDI merge box to connect several MIDI controllers into E-Scape, which then 

outputs MIDI into a single sound module as above. Also as above, every person can play at the same 

time - some people are simply playing their keyboard etc, with others using MIDI notes or normal 

switches or mouse to trigger musical material from E-Scape. However, the key point with this 

arrangement is that as all the performers are playing through E-Scape (MIDI 'thru') and everyone's 
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playing can be recorded and edited in E-Scape. It also results in a comparatively simple set-up: just a 

single computer, one set of speakers and one sound module etc. This arrangement is now used 

exclusively by Drake East Midlands disabled performers, in workshops and concerts. 

 

 

 

 

 

 

 

 

 

3.2 Setting up switches 

3.2.1 Switch Interfaces 

E-Scape as with many other types of switch operated software, uses the '1' '2' and '3' keys for menu 

control. Therefore your switch interface needs to simulate pressing these keys on the PC keyboard 

(see 2.2.7 for more details). 

Some interfaces have sockets for many different keys, and it is simply a matter of plugging your 

switch into the correct sockets (i.e. those marked '1', '2' and '3'!). Others need some simple set up, 

either on the box itself, or on the PC. For example: 

• Don Johnston 'Switch Interface Pro': press 'Scroll lock' on the PC keyboard, and follow the 

third row of socket labels (fig. a). 
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• Don Johnston 'Switch interface Pro5': press the small button on the interface until the light 

goes green, and follow the third (green) row of socket labels (fig b). 

 

(a)    (b)  

 

3.2.2 PC Keyboard Settings 

If you are operating E-Scape via the keyboard, or a switch interface (which remember is acting as if 

you have pressed the keyboard), then you will probably need to make specific settings on your 

Windows 'Accessibility Options' control panel  (as well as the 'Keyboard', and 'Mouse' control panel 

settings you normally use).  

The main setting is the 'keyboard repeat', which can repeat a character if you hold a key down. If this 

is enabled, then E-Scape will repeatedly scroll down a menu or conduct. You will likely not want this 

to repeat.  

Here's how to set the keyboard repeat off: 

(a) Setting Keyboard Repeat OFF 

(i) Open the 'Accessibility Options' Control panel (Windows 98 -  Start menu -> Settings-> 'Control 

Panel', Windows XP - Start menu -> 'Control Panel'). 

(ii) Make sure the 'Keyboard' tab is selected. 

(iii) Tick 'Use Filter Keys' in the middle section. 

(iv) Click on the middle 'Settings' button – the settings panel will open. 

(v) Tick the lower of the 'Filter options', i.e. 'Ignore quick keystrokes' 

(vi) Click on the lower 'Settings' button. 

(vii) Select the upper option: 'No keyboard repeat'. 

(If you want the 'slow keys' feature – i.e. have to hold down the key / switch for a time before it is 

accepted - you can also set it there.) 

(viii) Select 'OK'. 

(ix) Click on the 'Click and type here' panel, then press and hold any letter key to test - it should just 

type a single character no matter how long you hold the key down for. If you want a beep when you 

press a key or switch, then you can also select that here. 

(x) If all is well, press 'OK'. 
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(xi) Press OK and the Control panel should close 

 

Now, each time you press a switch, or e.g. the Space, the menu should go down just one item, and 

stay there. 

(b) Using Keyboard Repeat 

On the other hand, if you have good control over how long you hold a switch or key down, then you 

could try using 'keyboard repeat' as a function - for example you could hold the switch down, and let 

the menu scroll down at the speed you have set in the control panel. To do this: 

Do steps i- iii as above. 

In step vii above, select the lower option: 'Slow down keyboard repeat rates', then use the sliders 

below to choose a delay (how long to wait before repeat starts) and 'rate' (how fast the repeat 

happens). 

Continue with steps viii, ix and x as above. 

3.3 Setting up speech output 

First, you need to launch the speech synthesiser you are using (see 2.2.8). You then need to set it to 

'auto-read’ the windows clipboard. 

For example: 

- in 'Windbag', select 'Clipboard' then tick the 'Auto' box. 

- in 'Reader, open the 'Settings' menu, and make sure 'Speak' and 'Auto-read' are ticked (but 
not the other options).  

Instructions on setting these up are also given on screen, when you switch speech on within E-Scape. 

3.4 Setting up the keyboard 

If using the keyboard (e.g. Space and <Enter>) to operate E-Scape menus, you will also probably 

want to use the Keyboard Repeat settings as for switches. (See 3.2.2 above) 

If you are using the keyboard directly to operate E-Scape menus or shortcuts, you will also probably 

want to use the 'Sticky Keys' feature in the 'Accessibility Options' Control Panel. 

This enables users to input key commands which involve a ‘modifier’ key (such as CTRL or ALT) and 

another key. Instead of being pressed simultaneously, the keys may now be pressed sequentially. 

(a) To turn on Sticky Keys 

i. Open the 'Accessibility Options' Control panel (Windows 98 -  Start menu -> Settings-> 'Control 

Panel', Windows XP - Start menu -> 'Control Panel'). 

ii. Make sure the 'Keyboard' tab is selected. 

iii. Tick 'Use StickyKeys' in the top section. 

iv. Press OK and the Control panel should close 

(b) To adjust Sticky Keys settings 

Follow steps i-iii as above, click on the top 'Settings' button to open the settings panel. 
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4. Controlling E-Scape  

4.1 Overview 

All operations in E-Scape - writing and editing music as well as and live performing - can be controlled 

by 4 input methods: switches, MIDI, keyboard, and mouse. 

- 1 to 4 Switches, connected via a PC switch interface (see 3.2.1), to operate menus and 

procedures. 

- MIDI notes which act as switches - again to operate menus and procedures. 

- PC keyboard, to operate menus and procedures, or direct shortcuts. 

- Mouse etc, operating conventionally 

All these methods can also be used directly to perform your music live (see 5.7). 

All methods can be used in combination at any time – e.g. you could select an option (e.g. 'select 

notes') from a menu with the mouse, which is then operated using the keyboard (e.g. Space and 

Enter). Or you could use the mouse to select notes, and then use switches to control menus to edit 

them. 

These methods work in 3 ways: 

4.1.1 Pop up menus 

A series of pop-up menus guide the user through the choices and operations available. Menus can be 

operated using: 

• Switches - single switch; two switches; three or more switches. 

• Notes from any MIDI device, e.g. MIDI keyboard, MIDI drum pad, SoundBeam, MIDICreator etc. 

• Computer keyboard (or emulator).  

• Mouse (or emulator). 

4.1.2 Keyboard shortcuts 

Many operations can be quickly carried out with key-presses. A full list of keyboard commands is 

given in chapter 8. 

4.1.3 Drop down menus 

Conventional drop-down menus and buttons are also available, for users who can use a mouse or 

trackball etc. However, as E-Scape has been designed for ease of use via switches or keyboard, for 

most operations it is actually often faster to use these rather than the mouse!  

4.2 Ways of operating E-Scape 

4.2.1 Operating via Pop-up Menus (e.g. switches) 

You can do almost everything in E-Scape using a series of pop-up menus. These can be operated in 

four ways. All methods can be used in combination at any time. 
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(a) Operation by 'two or more switches' 

• Pressing Switch 2 (or Space) opens the top-level pop-up menu, and then scrolls down one item at 

a time. Within a procedure, Switch 2 does the next operation (e.g. if selecting notes, Switch 2 

selects the next note; if moving notes backwards, Switch 2 moves them one step back). 

• Pressing Switch 1 (or Enter) selects the current menu item, or finishes an operation (e.g. stops 

selecting notes or stops moving them).  

• You can also use a third switch (Switch 3) to scroll up the menu.   

NB. A quick way of scrolling straight round to the bottom item in a menu is to press <Switch 3> when 

the menu first appears. 

• If using two or more switches, you can specify to use a 'debounce' feature which stops you 

pressing a switch too often (e.g. to avoid an accidental second press as you take your 

hand/foot/nose away from the switch). You can set this feature to on or off, and also specify how 

long the system will wait before it will accept another switch press (see 4.3.4). 

(b) Operation by 'Single switch (scanning)'  

• If you want to use a single switch, then it should be 'Switch 1'. You need to set up E-Scape to use 

single switch (see 4.3.1). 

• Pressing Switch 1 opens the top-level pop-up menu. The menu then scans down (i.e. scrolls down 

each item) automatically with a set 'scan delay'.  

The Scan delay specifies how long the menu will delay on each item, before moving to the next. 

You can set what delay time to use (see 4.3.4). 

If an operation (e.g. moving notes) is started, then it carries on automatically, e.g. the notes move 

one step at a time, delaying each time (by the same 'scan delay' time as for the menu). 

• Pressing Switch 1 always selects the current menu item, or finishes an operation, e.g. stops the 

notes moving. 

(c) Using a switch interface to operate menus 

• You can use 1, 2, or 3 switches connected via a PC switch interface. 

• First, make sure your switch interface is "pressing" keys '1' '2' and '3' (see section 3.2.1), and 

connect your switches into the correct sockets.  

• It is a good idea to label your switches. The switch controlling the '1' key is called ‘Switch 1', (with 

2 =  'Switch 2', and 3 = Switch 3'). 

• There are two switch modes for E-Scape. The default is for operation by 'two or more switches', 

but you can also set it to operate with 'single switch (scanning)’, which means you only need to 

use a single switch ('Switch 1'). 

(d) Using MIDI notes to operate menus 

You can assign one or more MIDI notes to act as each of three switches. Pressing these MIDI notes 

then behaves just as for Switches 1, 2, and 3 above, to control the operation of menus and 

procedures. This is useful if: 

- You don’t have a switch interface. 

- You prefer to work with a music keyboard or drum pad in front of you than a computer 

keyboard or switches. 

- You want to enter notes by playing on a MIDI keyboard ('MIDI step entry'), but can't (or don’t 

want to) reach over to another set of switches or keyboard to operate E-Scape. 
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- You have a special sensor (e.g. with MIDIcreator or Soundbeam), which you want to use to 

operate E-Scape. 

These MIDI notes can come from a variety of devices: 

• Notes or groups of notes from a MIDI keyboard or drum pad. 

• Up to 8 Switches, connected e.g. via a MIDI instrument like MIDIcreator or Soundbeam 

switchbox. 

• MIDIcreator event sensors, e.g. MIDIblock or MIDI floor pad. 

To set up MIDI notes as switches{ XE "MIDI notes as switches" }, see section 4.3.3 below. 

(e) Using the computer keyboard to operate menus 

You can operate popup menus using the computer keyboard in a similar way to Windows.  

NB. You may want to set the Keyboard Repeat OFF - see 3.2.2. 

• <Space>    - opens top-level menu, and scrolls down. 

• <Cursor down>  - scrolls down menu.   

• <Cursor up>   - scrolls up menu. 

• <Enter>  - selects current menu item. 

• <Esc> or    <`> - cancels menu. 

• <Cursor right>  - scrolls down three items at a time (useful for longer menus). 

• <Cursor left>  - scrolls up three items at a time. 

Hint: To scroll round to the bottom item in a menu when it first appears, press <Up cursor>. 

(f) Using Mouse to operate menus 

You can still operate pop up menus with the mouse, although this is not particularly recommended. 

This might be useful e.g. if you are a mouse user, teaching a switch user. 

4.2.2 Operating via Keyboard 

As well as operating the pop-up menus, you can use various keys as shortcuts to start a procedure or 

open a menu, e.g. 'Enter' start playing, and 'E' opens the Edit menu. 

For a full list of shortcuts, see 'Keyboard control' - Chapter 8. 

You can also see the list of shortcuts within E-Scape, using the mouse:  from the 'User / Setup' menu, 

select 'Keyboard shortcuts info'. 

4.2.3 Operating via Mouse 

Using a conventional mouse or trackball (or mouse emulator, e.g. Windows 'mousekeys', P&G 

joystick, or Tash 'mousemover'), you can operate E-Scape as for conventional music software, using 

drop down menus and buttons etc. 

NB1. The present version of E-Scape does not have the full compliment of mouse-operated tools and 

control panels you will find in most conventional MIDI / audio sequencers - it is optimised more for 

switch or keyboard users. However, these features are planned for future releases. 
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NB2. Usually, it is faster to use the keyboard or menus rather than the mouse. 

4.3 Setting up Switches (1,2,3) 

4.3.1 Using switches - a recap 

• You can use 1, 2, or 3 switches (called 'Switch 1', 'Switch 2' and Switch 3'), which can be 

connected via a switch interface, or be assigned to MIDI notes (coming from keyboard, drum 

pad, MIDIcreator or Soundbeam). 

• You can set the number of switches to use (either 'Single switch' or 'Two or more').  

• With a single switch, you can also set the scan delay time which controls how fast the menu 

scans.  

• For two or more switches, you can set 'de-bounce' as well as the 'de-bounce time' – i.e. the 

time to wait before the next switch press is accepted. 

NB. All these switch settings also apply to control of menus by keyboard, and by MIDI. 

4.3.2 Settings window and menus 

(a) Keyboard and mouse users can change user settings most easily by opening the ‘Settings’ 

window: 

Keyboard: Press S 

Mouse:  Open 'User / Setup' menu, and select 'Open Settings'. 

This Settings window gives access to some of the MIDI parameters in its lower panel, and has 

mouse-operated drop down menus for all settings.  

In addition, there is a pop-up Settings menu, which has most (but not all) of the settings options. This 

can be opened in the Settings window by pressing Switch 2 or Space. 

(b) Switch users can open the pop-up Settings menu directly from the Score window: 

Switch: Main menu (press Switch 2 or Space) -> 'Other things' -> Settings. 

4.3.3 Setting Number of switches 

By default, E-Scape's popup menus are operated using two or three switches (see 4.2.1), to scroll 

and select menu items. You can also select to use a single switch ('Switch 1'), in which case the 

menus will scroll by themselves. 

Switch: Main menu (Switch 2 or Space), select 'Other things' -> Settings -> Switches -> 

'Number of Switches'. 

Then choose 'Single switch scanning' or 'Two or more switches'. 

Keyboard: From the Settings window (see 4.3.2), press Space (or S) to open main Settings 

menu, then select -> Switches -> 'Number of Switches'. 

Then choose 'single switch scanning' OR 'two or more switches'. 

Mouse:  In Settings window (see 4.3.2), open the 'Switches' menu, and select 'Number of 

Switches'. 

Then select 'Single switch (scanning)' or 'Two or more switches'. 
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NB. Single switch operation using the 'dwell' method is not currently supported (although it is present 

in a previous Mac version) - please contact the developer if you need this feature. 

4.3.4 Other switch settings for menu control 

(a) Scan delay (single switch) 

If you are using single switch, the menu scans (steps down each option) by itself, and you can choose 

the delay time between each step. This is done from a menu that has delays in 0.25 sec steps up to 4 

seconds, plus a further option that has delays from 5 - 20 seconds.  

To set the scan delay: 

 

Switch: Main menu (Switch 2 or Space) -> 'Other things' -> 'Settings' to open the Settings 

menu. 

Then select 'Switches…' -> 'Set menu Scanning delay time'.  

NB. This option will only be available in the 'Switches' menu if you are already set to 

use a single switch. 

Keyboard: From the Settings window (see 4.3.2), press Space (or S) to open the Settings menu.

Then select Switches -> 'Set menu Scanning delay time'. 

NB. This option will only be available in the 'Switches' menu if you are already set to 

use a single switch. 

Mouse:  In Settings window (see 4.3.2), open the 'Switches' menu, and select 'Single switch 

scan delay' 

 

(b) Debounce on/off   (two+ switches) 

If you are using two or more switches, you can turn on the 'debounce' function. This means that if by 

mistake you press the switch (or Space) again shortly after the first time, it will be ignored. This is also 

useful if you have a switch, that sometime clicks on again after you release it (i.e. which 'bounces' 

back on). Remember that this function has no relevance if you are using a single switch. 

To switch this function on: 

 

Switch: Main menu (Switch 2 or Space) -> 'Other things' -> 'Settings' to open the Settings 

menu. 

Then select 'Switches' -> 'Set Switch Debounce on or off'. 

NB. This option will only be available in the 'Switches' menu if you are already set to 

use two or more switches. 

Keyboard: From the Settings window (see 4.3.2), press Space (or S) to open the Settings menu.

Then select Switches' -> 'Set Switch Debounce on or off'. 

NB. This option will only be available in the 'Switches' menu if you are already set to 

use two or more switches. 

Mouse:  In Settings window (see 4.3.2), open the 'Switches' menu, and select '2 Switch 

debounce on or off'. Then select 'ON or OFF’. 
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(c) Debounce delay (two+ switches) 

If using the 'debounce' function (with two or more switches), you can specify how long E-Scape will 

ignore a repeated switch press. For example, a longer delay can be useful to allow you plenty of time 

to fully release the switch (i.e. get your hand/ head/ foot etc away) ready for the next press. 

 

Switch: Main menu (Switch 2 or Space) -> 'Other things' -> 'Settings' to open the Settings 

menu. 

Then select 'Switches' -> 'Set Switch Debounce delay'. 

NB. This option will only be available in the 'Switches' menu if you are already set to 

use two or more switches. 

Keyboard: From the Settings window (see 4.3.2), press Space (or S) to open the Settings menu.

Then select Switches' -> 'Set Switch Debounce delay'. 

NB. This option will only be available in the 'Switches' menu if you are already set to 

use two or more switches. 

Mouse:  In Settings window (see 4.3.2), open the 'Switches' menu, and select '2 Switch 

Debounce delay'. 

4.3.5 Setting up MIDI notes for switches 

MIDI notes can be assigned to act as Switches 1, 2 and 3. They can come from a MIDI keyboard or 

drumpad, or specialist devices such as MIDIcreator or Soundbeam. As every function in E-Scape can 

be operated via switches, this gives enormous flexibility in enabling anyone to operate E-Scape with a 

huge variety of interfaces. 

Wherever they come from, playing a MIDI note is then treated exactly the same as a 'normal' switch, 

and all the settings above will apply.  

To assign MIDI notes to each switch, e.g. for Switch 1: 

a) First start the procedure:  

 

Switch: From Score window: 

Open Main menu (Switch 2 or space), then select 'Other things' -> 

Settings -> 'MIDI control' -> 'Switch 1: set MIDI notes' 

Keyboard: Press 'S' to open the Settings window. In the Settings window: 

Open the main menu (Space or S), then select 'MIDI control' -> 

'Switch 1: set MIDI notes' 

Mouse: In the Settings window:  

Either, open the 'MIDI control' drop-down menu, and select 'Learn 

MIDI notes to act as Switch 1'. 

Or, click the 'Learn' button in the 'MIDI notes for Switch 1' panel in 

lower half of window. 
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b) Then play one or more MIDI notes, then press Switch 1 or Enter to finish. 

You can assign a series of notes to each switch if you want to - which is useful for users who find it 

hard to hit one particular note on the keyboard, for example. 

NB1. Multiple notes assigned to each switch must be continuous - e.g. you could assign all the notes 

between C3 and G3 to act as Switch 1, but not just (e.g.) the notes C3, E3 and G3. 

NB2. If you try to assign the same notes for this switch as are already assigned to other switches, you 

will be prompted to try again. If you do want these notes, you will usually have to go back to the other 

switch and assign different notes to it, before you can then assign those notes to this switch. 

NB3. If you are already operating E-Scape using MIDI notes as switches, then you can not at present 

set up MIDI notes in this way, i.e. you need to use ‘normal’ (ie not MIDI) switches in order to set up 

MIDI for switch control. This will be addressed in a future release – meanwhile, if this is a problem for 

you please contact the developer via www.DrakeOnline.org >> Instruments >> E-Scape. 
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5. A Guided Tour of E-Scape 

Let's have a short look round E-Scape. Sometimes you will be asked to perform an operation, but 

detailed explanations will wait until Section 6 - here you are doing things just to enable us to show you 

round, and get a feel of the system. For this tour will use keyboard shortcuts where available, as well 

as the method for switch users. 

5.1 Starting up 

If E-Scape isn’t running, then open it. Start Menu -> Programs -> E-Scape -> E-Scape 2.x   (where x 

is the latest version you have) 

You are first presented with a Pop-up 'welcome' menu, which asks you to choose a 'user' for E-Scape 

(each user has their own Scores and Settings). Next we will talk about operating this pop up menu - if 

you are already familiar with it, then you can jump to 5.3. 

 

5.2 E-Scape's Pop-up Menus 

For switch or keyboard users, these 'pop-up' menus can be operated in many ways: by switches (1 

and 2), by keyboard (Space and Enter), or even by MIDI notes acting as switches (see 4.3.5). 

5.2.1 Scrolling  

If you have switches connected, use Switch 2 to scroll down this menu, otherwise use <Space> or 

<Down cursor>.  

We will mostly just write 'Switch 2' from now on to keep things simple, but remember that pressing 

Space is directly equivalent. You can also use Switch 3, or <Up cursor> to scroll up. (For full details 

on how to operate these menus see 4.2.1.) 
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5.2.2 Selecting 

If you have switches connected, use Switch 1 to select an option, if otherwise you can use the 

<Enter> key to act in the same way. You can of course use the mouse, but it is a good idea to use the 

keyboard or switches to get a better feeling for the system - it is also usually faster than reaching for 

the mouse. 

5.3 Creating a new user 

• If this is your first time using E-Scape, please now select 'New person' using Switch 1 (or 

Enter).  

• Or, if you have used E-Scape before, you could alternatively choose a user you created 

earlier: if so, you can now jump to section 5.4. 

• To create a new user, you are first asked to enter your name, and asked if you will be typing it.  

• If you are a switch user, or exclusive mouse user, select 'No', and you will be presented with a 

letter grid (a): 

• If you select ‘Yes’ you will be presented with a text dialog (b) to type into: 

(a)    (b)  

Later on in normal use, E-Scape will automatically detect whether you used the keyboard or switches, 

and present the appropriate text entry method. 

• Next, choose if you want speech output on or off: 

 

• Unless you are working with a non-reader, or someone who has a visual impairment choose 

'OFF'.  

If you switch it ON, you will be informed about using a speech synthesiser with E-Scape - see 2.2.8 

for more details. 
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Next, you are asked if you want to use 1 or 2 switches: 

 

• Unless you are a single switch user, choose 'Two or more switches'.  

For clarity, the following tour is written assuming you are set to use two+ switches, but if you are a 

single switch user, everything still works - all you need to do is ignore all references to Switch 2 in the 

text, and either press Switch 1 (e.g. to open the main menu), or simply wait for items to step through 

automatically.) 

You are now presented with an empty Score window, representing a single music of track. Let's now 

have a look around it. 

5.4 The Score Window  

The Score window you see is the main window of E-Scape where most things happen. If you have 

just started E-Scape, the Score will be empty and called 'Unnamed'.  

If you open or create more Scores, they will all be open but only one will be visible. 

Using the mouse, you can collapse the window, and use the Windows task bar to expand it again. 
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Let's look at the different parts of the window: 

5.4.1 Drop down menus 

There are two kinds of menu in E-Scape. We saw the pop-up menus earlier when we first started up 

E-Scape. 

There are also more conventional menus that appear on the top left of the Score window, and are 

operated by mouse in the usual way. They are useful for quick access to mouse users who are 

perhaps setting things up for one or more switch users (e.g. in the classroom), especially for 

performing. Future development will also make these menus available to switch users. 

5.4.2 Step entry information panel 

Also at the top of the window, to the right of the menus, is a status panel. This tells you three things: 

(a) The current 'step length' for this Score. This specifies how long notes will be when entered from 

the menu (or MIDI) by 'step entry'. The default step length (duration) is '1 beat', i.e. a crotchet (US 

'quarter note'), but you will normally set this to various durations when entering a series of notes.  

Notice that the display shows '1 beat' and not 'crotchet', as E-Scape does not try to assume you know 

anything about music theory. However, you choose to use more formal musical terminology (e.g. 

crotchets, quavers etc), by changing the 'Duration mode' - see 7.1. 

(b) The tempo for this Score, shown in beats per minute (bpm). To change the tempo, see 7.2. 

Please note that in the present version of E-Scape, the time signature is fixed to 4/4 time, that the 

tempo is fixed and can’t change part way through the Score. 

(c) The 'key' you have chosen to work in. The default is to have 'no key', i.e. you are using all the 

notes of the scale, and transposing chromatically. To choose a different key, see 7.3. 

5.4.3 Track buttons 

You can see a single track at the moment. On the top left are mouse-operated buttons, which operate 

on that track only: 

• The note head (quaver) button will play the track (as visible on the current page). 

• The [M] button will mute (and un-mute) the track, so it will not be head when playing the 

Score. 

5.4.4 Track info display 

At the top of each track is also displayed information about that track. At the moment only the MIDI 

channel is displayed (most likely it will be 1), plus the track name, which at the moment is 'Unnamed'.  

You can rename the Score at any time (e.g. from the drop-down 'Score' menu), or give it a new name 

if you save it using 'Save as'. 

We will come back to the track info display in a moment, but first let's complete our look round the 

Score window. 

5.4.5 Time ruler 

Below the bottom track (or the single track in this case), is the time ruler, which shows time measured 

in bars and beats. At present E-Scape is restricted to 4/4 time, hence there are 4 beats (crotchets) to 

the bar. In the ruler: 
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• Bar numbers are shown as black lines and numbers. 

• Beats (i.e. crotchets) are shown as smaller numbers, e.g. in bar 2, the beats are shown as:  

- Bar 2, beat 1 (i.e. '2:1') shown as just a bold '2'. 

- Bar 2, beat 2 (i.e. '2:2') shown for clarity as just ': 2’ (unless zoomed in more). 

- Bar 2, beat 3 shown similarly as  ': 3’, and Bar 2, beat 4 shown as ': 4’. 

• Between the beats are further smaller divisions, which notes and cursors will 'snap' to when 

moved (or when notes are quantised etc). You can’t move between these small divisions. By 

default, the 'snap' is set to a quarter of a beat (i.e. a semi-quaver), but you can change it - see 

6.8.4b. 

Clicking or dragging the mouse in the time ruler is a quick way of moving the step time cursor (red 

line), but leave it alone for the moment. 

5.4.6 Scroll bar 

Below the time ruler is a conventional scroll bar. At the moment it is all shaded (green) as you are 

viewing the entire page. Later, we will zoom in and look at this more. 

5.4.7 Bottom information panel 

Most of the bottom of the window is taken up with the information panel. This shows information about 

what to do, what is happening etc. Is also changes colour when you are in particular modes e.g. when 

step recording it goes Red; when performing it goes green. 

5.4.8 Play button 

In the bottom left is a large 'Play' button [>]. This will play all tracks on the current page. There is no 

Stop button at present - you press Switch 1 (or Enter) to stop play.  

NB. Future releases of E-Scape will have more mouse buttons to play and locate functions. 

5.5 The Settings window 

Let's now open the other main window in E-Scape - the 'Settings' control panel: 

Switch: Open main menu (Switch 2 or Space)  

Then select 'Other things' -> 'Settings' -> 'Open Settings window' 

Keyboard: Press 'S' 

Mouse: Open the 'User / Setup' menu, and select  'Open Settings window' 

• Open the Settings window using one of the above methods.  

NB. If you are a switch user, you do not actually need to have the Settings window open (at the 

moment it just gives some feedback on MIDI settings): you can open this menu directly from the 

Score window: Open main menu (Switch 2 or Space), then select 'Other things' -> 'Settings'. 

• The settings window also shows some of the MIDI parameters - ignore these for now. 
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This window has drop-down menus (operated by mouse) for all E-Scape settings. There is also a 

'Settings' pop-up menu for switch and keyboard access:   

 

From the Settings window, press Switch 2 or Space to open this menu.  
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• Now go back to the Score window:  

 

Switch: Press Switch 2 for Settings main menu, and select bottom item 'Go 

back to Score window'.  

Keyboard: Press S, or press Alt-F4 (as normal for Windows) 

Mouse: Click on 'Score window' button. 

5.6 First steps with E-Scape 

We are now going to do some basic operations, during which further features in the window will be 

revealed. 

We will operate for the moment using the pop-up menus operated by switch or keyboard. The same 

options are also available in the drop down menus (although in different places), but for now let's try it 

as a switch or keyboard user.  

Lets now add some notes (using switches) and create a short tune. 

5.6.1 The 'step cursor' 

First, look carefully at the far left-hand side of the track; you can just see a red line. This is the 'step 

cursor', which governs where newly entered notes, (or even a whole live recording) will be placed. 

Later on, we will move it about, but for now leave it alone, and we'll add our first note, which will start 

where the step cursor is, i.e. at the start of the Score. 

5.6.2 Adding a note 

• Press Switch 2 (or Space) to open the main (top-level) pop-up menu.  

 

This has various options to enter notes, edit, perform and play music - most lead to further menus. 

• Scroll down using Switch 2 (or Space), and select the first option: 'Enter notes…’  

Hint: If you go too far, you can keep going to the bottom, and scroll back round to the top, or use 

Switch 3 or <Up Cursor> to go back up. 
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This menu has a number of options, all to do with entering notes. For example, you can also move the 

cursor position (red line) where a new note will be entered, and choose the duration of a note - by 

default it is set to be 1 beat (a crotchet). 

• Again, select the first item 'Add note…’ 

Before a note is added, you are first asked to choose an instrument sound, as no instrument is so far 

assigned to the track.  

5.6.3 Choosing an Instrument 

E-Scape uses MIDI instruments, and you can select which one is used in a track. This uses two 

menus, which also audition what each instrument sounds like. You first select a group of eight 

sounds, and then select one sound from that group. 

(a) Select an instrument group 

You are first presented with a menu with groups of eight sounds.  

 

If you scroll down the menu using Switches or keyboard (Space), then each sound in the group 

auditions (unless using the mouse); if you had some music already in the track, part of this would be 

played, but as there is not, you just get three notes an octave apart.  

If you hear a sound you like, you can interrupt to select this group by pressing Switch 1 (or Enter), or if 

you don't want a group, you can interrupt with Switch 2 (or Space) to scroll down to the next one. 

• Scroll down the menu (using Switch 2 or Space) and select one of the instrument groups. 

Make sure you wait sometimes to hear the auditioning. 
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(b) Select one instrument 

Next you are presented with a similar menu with the eight sounds from the group you selected. 

 

Again, if you use the keyboard or switches to scroll, then each sound will audition. 

• Select the sound you want with Switch 1 (or Enter) as usual, or select 'Go Back' to return to 

the instrument groups menu.        

• Finally, the new note will be entered, at pitch A (the A below middle C - called 'A2'). This note 

then plays repeatedly. 

• Press Switch 1 (or Enter) to stop play. 

5.6.4 Audition / transpose procedure 

You are now held in a procedure which lets you repeatedly transpose and audition This procedure is 

designed to allow a switch user to enter a note and choose the pitch 'by ear', with the least effort. If 

you want to enter a note with a specific pitch there many other are ways to do this quickly - see 

Tutorial 1. 

The procedure first invites you to transpose the note up or down (a):  

 

• Select to make the note higher. You are then informed about how to operate the procedure:  
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Each time you press Switch 2 (Space) the pitch is increased one step. Notice that the bottom 

information panel now shows the position, pitch and duration of the current note. 

If you wait the note is automatically auditioned, repeatedly. Of course at the moment there are no 

other notes to audition, so you will just hear the single note each time. 

• Press Switch 2 (Space) to transpose the note up a few times. 

• Then press Switch 1 (Enter) to stop auditioning. 

• You are now asked to confirm if you have the pitch you want, or want to correct it, or continue 

transposing:  

   

• Continue with this procedure, until you want to finish, then you should select 'OK'. 

The 'Enter notes' menu will then reappear (assuming you may want to enter further notes), and your 

'Score' should now look something like this: 

 

Notice that the menu now has a new top item: 'FINISH - entering notes', and will keep reappearing 

until you select this (or 'CANCEL').  
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• Leave this menu there for the moment and let's have another look at the window. 

5.6.5 More on the Track information display 

Now you have your new note in place, you will notice two things: 

(a) The step cursor (red line) has moved to the end of the new note. This means you can quickly enter 

a series of notes one after the other. In a moment we will move the cursor manually. 

(b) The track information (displayed at the top of the track) now shows three more pieces of 

information: 

- The current position of the step cursor, e.g. Bar 1 Beat 2. 

- The pitch of the selected note, for example 'D3' is the D above middle C. 

- The 'loudness' of the selected note - with 12 levels. This refers to the dynamic level of the note and 
is also a simplified reference to the MIDI note 'velocity' (see 6.1.8).  This language is used with the 
aim of shielding a user from unnecessary technical or musical terminology. 

5.6.6 Moving the step cursor 

Let's now move the step cursor: we will use a further menu, and further keyboard shortcuts. 

• Scroll down the 'Enter notes' menu (again using Switch 2, or Space), and this time select: 

'Move cursor position'. 

You now are presented with a menu with several ways to move the step cursor:  

 

(a) Moving step cursor (by snap) 

Let’s first try moving the cursor by the smallest allowable interval - the 'snap'. By default this is set to 

1/4 beat (semiquaver), as shown in the menus. You can change this 'snap' amount - see 6.4.8b. 

• Select the third option: 'Repeat go Backwards - by 1/4 beat (snap)'.  
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An info window then pops up:  

   

This reminds you how to operate this procedure: each time you press Switch 2 (or Space) the cursor 

will move backwards by 1/4 beat, until you press Switch 1 (or Enter) to finish the procedure. Notice 

that the wording of the info will be slightly different, depending on whether you have used Switches (1, 

2, etc) or keyboard (Space, Enter) to get here. 

• Continue from the info window (Switch 1 or Enter) 

• Then press Switch 2 (or Space) a few times to move the step cursor. 

Notice the step cursor position display changing at the top of the track. 

• Then press Switch 1 (or Enter) to stop moving, i.e. to finish the procedure. 

A further menu now gives you the opportunity to confirm you are in the right place, or if not to move 

again. 

  

(b) Moving cursor by bars 

• Select 'Move cursor again' to get back to the 'Move cursor position' menu - as in (a) above. 

• This time select 'Repeat go to next bar - backwards'. 
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Again, an info window reminds you what to do: 

 

• Continue form this window (Switch 1 or Enter). 

• Now press Switch 2 (or Space) to move the cursor backwards, until it is at the start of the page 

- then continue some more.  

Notice that the cursor scrolls round to the end of the page. 

• Move the step cursor until it is at the end of the first bar (i.e. at Bar 2, Beat 1), then press 

Switch 1 (Enter) again to stop. 

Again a menu will appear - as in (a) above - asking you to confirm 'OK' or move again.  

• This time, select 'OK'.  You are now back in the 'Enter notes' menu.  

NB. Later on, we will see how to move the cursor using keyboard and mouse (see 6.4.3). 

5.6.7 Adding more notes 

The 'Enter notes' menu should be open again: 

 

NB1. If you had closed it, then open the 'Enter Notes' menu again, from the main menu as in 5.6.2 – 

NB2. In this case it will not have the 'FINISH' item. 

Using the 'Enter notes' menu, let's now add a second note.  

• Repeat the procedure as in the previous section, i.e. select 'Add note - 1 beat’  

• When you are asked what to do next (as before in 5.6.4), this time select 'Make note lower'. 

• Now press Switch 2 (or Space) a few times to transpose it down a few steps.  

• Make sure you sometimes wait between presses, and you will hear the note audition 

automatically along with the first one. 
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This is the easiest way to enter notes for complete beginners - they can choose pitches 'by ear' 

without needing to know about note names. Later we will look at other ways of entering notes more 

quickly, and employing more musical knowledge (see 6.4.2) 

• Before you finish this menu, try exploring the 'Enter notes' menu a little more - you should not 

be able to 'go wrong' as the menus guide you.  

- Try adding a few more notes using the menu.  

- Try going into 'Enter chords' and exploring that. 

- Finally, select 'FINISH - entering notes' 

• Now, try adding notes using keyboard shortcuts: e.g. press  [=]  to add and audition, or press  

[+]  to add a note without audition. 

5.6.8 Changing the step length 

Now let's add some notes that are not one beat long. To do this, we first set a 'step length’, which 

specifies the duration for any notes added in future. By default, durations are expressed in 'beats' 

(assuming a 4/4 time signature) which is easy to understand for beginners to music. 

You can also set durations to be shown in conventional music terms, e.g. crotchets, quavers etc - see 

7.1 for details. 

(a) Set step length using switches 

• Again open the main pop-up menu (Switch 2 or Space), and again choose the top item: 'Enter 

notes'. 

• This time select 'Choose step length  [for adding notes]'.  

This opens a menu where you can choose and audition a new 'step length': 

 

• Scroll down the menu, again using Switch 2 (or Space).  

• Make sure you pause on some items  - the menu will then audition the selected note length 

with a 2 bar sample: notes of two pitches are played with the selected duration, with a drum 

beat backing. 

NB. If you use the mouse to scroll down the menu, then you will not get auditioning, nor will you if you 

have duration mode as 'note lengths' (see 7.1). 
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• Choose a different step length (duration) than 1 beat. You will then be prompted if you want to 

enter another note straight away with this duration. 

 

• Say 'Yes' to add a note.  

• Now, again follow the transpose / audition procedure, as in 5.6.4, finishing with 'OK'. The 

'Enter notes menu will reappear again  

• Select 'FINISH - Entering notes' to get back to a clear Score window - you should now have 

three notes. 

(b) Set step length using keyboard 

• Change the step length again, but this time use shortcut 'D' to open the 'Step length' menu. 

(c) Excercise: Adding notes of different duration.  

• Repeat the above steps in (a) and (b) a few times, to add notes and change the step length - 

so as to enter a number of notes, with several different durations. 

5.6.9 Deleting a note - and introducing the Yes / No dialog 

Let's try deleting a note, which also shows how E-Scape asks you to confirm an action.   

• First, let's remove a note using switches: press Switch 2 (Space) as usual for the main pop-up 

menu, then select 'Edit' to open the 'Edit Notes' menu: 

 

• Select 'Remove' 

You will then be asked to confirm via a menu that is operated by switches (or Space/Enter as usual). 

If you have speech output on, this will also speak.  
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(a)  

• Select 'No'. 

Secondly, let’s do the same thing, this time using a keyboard shortcut:  

• Press <Delete> or <backspace>. 

You are now asked to confirm via a different more conventional dialog. Pressing Switch 2 or Space 

(or Tab) will swap between 'yes' and 'no', and pressing  <Enter> will select. If you want 'yes', you can 

just press <Enter> straight away).  

(b)  

• Select 'yes'. 

NB1. If you use the mouse you will also get this conventional dialog (b). 

NB2. If you have speech switched on you will always get the speaking version (a), whichever method 

you use. 

 

5.6.10 Further exploration 

For a guided tutorial, please go to Section 6, but if you want to continue exploring E-Scape’s 

functions, you could try a few more things here: 

• If using keyboard, try using the <Up cursor> and <Down cursor> keys to transpose notes 

quickly.  

• Explore more of the options in the 'Edit Notes' menu (from the main switch menu, or shortcut: 

E). 

• When you have a few notes entered, try looking at the 'Copy' menu (from the main switch 

menu, or shortcut: C). For example, select the first option: 'Guided copy.' and follow the 

instructions. 

• Also try exploring the 'Other things' menu. 

It is suggested you leave the 'Perform' and Settings' areas alone for the moment. They are covered in 

sections 6.4 and 7 respectively. 
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5.7 First steps performing with E-Scape 

E-Scape lets you perform music live: this can be your own music, or you can load in other Score files, 

or MIDI files e.g. from the Internet.  

You can, for example, use a switch or the keyboard to 'conduct' the piece in different ways, playing 

small phrases ('segments'), or every note individually, by pressing a switch or key.  

You can also perform with E-Scape in other ways using the mouse, or use MIDI devices such as 

keyboards, drum pads, MIDIcreator or Soundbeam. 

Let's try some simple 'conducting', using a score, which has been prepared earlier. First, we need to 

make sure we can access the demonstration Score files. Each E-Scape 'user' has its own settings 

(although you can access other users' files as well), so we need to make sure we have selected the 

correct 'user'. You can create a different user for different people, or for different music sessions or 

classes etc. 

5.7.1 Changing user 

If you are not already, we need to make sure we are the 'Demo' user. To check, press Switch 2 (or 

Space) to open the main pop-up menu. The menu heading should say 'Switch menu for user - Demo'. 

If so, you can go to the next section 5.7.2. If not then we need to change to the 'Demo' user. We 

select it from a menu of users:  

• Using Switches, press Switch 2 (or Space) to open the main menu and scroll down.  

• Then select 'Other things', to open the 'Other things' menu: 

 

NB. If using keyboard shortcuts, you can press 'O'  to open this menu. 

• Then select 'Change to ANOTHER User…’ 

 

• From the menu of users, select 'Demo'. 



E-Scape: Getting Started Guide   © Inclusive Music, 2008                                                            41

You will then be asked if you want to save the settings of the previous user. 

• Select 'No' to saving previous settings, unless you have made significant changes to your 

settings so far. 

You will then be asked if you want to close any Scores that are open for the present user.  

•  Select ‘Yes' to close previous Scores.  

If any scores have been edited and not saved, you will then be asked what you want to save them as 

before closing. Usually at this point you will only have a few trial Scores, so you can close and not 

save them.  

• Select 'Close without saving' (if asked). 

You then get one or more info windows giving settings information about the new user. 

• Press Switch 1 (Enter) to continue.  

• You are now in the user 'Demo', which has its own Scores and settings, and we can go on to 

open one of them to try out. 

5.7.2 Opening a Score 

Now let's open a demo Score. First, open a menu of Scores for this user:  

• Open the main menu (Switch 2 or Space), and select 'File…' to open the File menu: 

 

• Then select 'Open Score'. 

This opens a menu of Score files on disk, in your own user area - at the moment you should be user 

'Demo'. You can also use keyboard shortcut: Ctrl-O to open this menu, or the mouse in the File menu: 

 

• From the menu of Scores, select 'Greensleeves1'. 

5.7.3 Playing back a Score 

Before we start performing, let's try just playing back the Score 'normally', i.e. making it play back by 

itself, just as in other music (e.g. 'sequencer') software. This is always useful to see what material you 

have. As we shall see later (6.2), some Scores may not be designed for this kind of playback (being 

more like sets of performing material), but in this case we can play the Score 'as composed' to see 

what it sounds like. 
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To play the whole Score (as visible on the current page): 

Switch: Main menu: Play 

Keyboard: Enter 

Mouse: Click on bottom left [>] button.  

   or, open 'Play' menu:  'Play Score (this page)' 

First try playing using Switches: 

• Press Switch 2 (or Space) to open main menu, then select 'Play'.  

• Press Switch 1 (or Enter) to stop play. 

• Then, if available, start play via shortcuts (press Enter), or via mouse (click on [>] button).  

• Again, press Switch 1 or Enter to stop play. 

 

5.7.4 Performing 

Now let’s try 'performing' this Score – i.e. interacting with it live, rather than just 'Playing' (i.e. making it 

play itself 'as composed').  

There are many ways of performing, but here we will just look at two - 'Conducting tracks' and 

'Conducting Score'. 

• First, press Switch 2 (or Space) to open the main pop-up menu, and then select 'Perform' to 

open the 'Perform' menu. 

 

You can also press 'P' to open this menu. 

5.7.5 'Track conducting' 

• Select the second item 'Conduct Tracks (by segment)'. 
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Notice that the info panel changes colour to green, to indicate you are now in a 'performance' mode.  

 
The normal switches and menus are not active - instead you are using switches directly to trigger 

music. The info panel informs you which controls do what - let's try some of them: 

• Press Switch 2 (or Space) once 

You will now hear a picked guitar chord, and can see a bold outline around the first few notes. This is 

a 'segment'. 

 

 

NB. These segments actually corresponding to a 3/4 bar, although as this Score was played in live 

without a metronome, these don't actually match up with the bar lines in the ruler. 

• Press Switch 2 again to 'conduct' each segment of the music in turn.  

You are conducting the top track ('Chords - guitar'). You can either wait until each segment has 

finished, or you can interrupt and go faster, or go slower. 

• If you are using it, try pressing Switch 3   (or <Down cursor>).  

This changes to make the second ('Melody - flute') track active, and the track name goes green to 

indicate this. 

• Again, conduct through the track with Switch 2 (or Space): 
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Notice that this time you are conducting every note of the melody, rather than longer phrases as you 

were on the guitar. This Score had segments set up like this already for each track, but segments can 

be quickly set up at any time, to suit the musical and practical needs of the performer - see 6.5.6. 

• Try going back and forth between the tracks with Switch 3, and conducting with Switch 2.  

You can imagine having many more tracks - each track could have a set of notes, phrases or chords, 

with variations of expression, or different instruments - think of it as a musical palette. 

• Now, press Switch 1 or Enter to finish conducting.  

NB. If you find you are conducting backwards with Switch 1 (instead of finishing), then press Enter to 

finish conducting. This will be explained in section 6.5.3(b). 

• Start track conducting again: if using the keyboard, this time use keyboard shortcut 'A', 

otherwise repeat using menus, as above. 

Again notice the info panel changing to green – and remember that while you are in conducting mode, 

the normal controls don’t work. 

• Finally, press Switch 1 or <Enter> to finish conducting, as before. 

There are also many other ways of conducting tracks, including using just a single switch – e.g. see 

Tutorial 6.2. 

 

5.7.6 'Score conducting' 

Now open the main menu again with Switch 2 (or Space), and select 'Perform' as before. Now this 

time, select the first option 'Conduct Score (by segment…)'.  

You are now conducting the whole piece as one: 

• Press Switch 2 or Space to conduct the Score.  
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• Try pressing faster and slower, or pause to hear and see what is going on. 

• Try to get the timing right to perform the Score 'as composed', i.e. as it sounds when played 

back normally (as in 5.7.4). 

• Then try your own interpretation - go faster or slower at different times to perform it differently. 

(a) Leading the Score from a track 

There is an important thing to notice: you are playing ('leading with') the top 'guitar' track, and the 

'flute' track is following – e.g. notice that several flute notes will be played on each switch press, to 

'keep up with' the guitar segment. The principle is that the segments present in the 'lead track' are 

used to govern how the whole score is conducted. 

The reason the top track is leading, is that when you started Score conducting, the top 'guitar' track 

was active. 

(b) Leading from a different track 

Let's now try Score conducting again, but this time we will 'lead' from the bottom 'flute' track. First we 

need to get back into normal mode (i.e. we need to stop conducting), and then we need to change the 

active track. Then we will start Score conducting again and notice the difference: 

• Press Switch 1 (or Enter) to finish conducting, if you haven’t already.  

NB. If you press the <Enter> key when in normal mode (pink info panel) the Score will start playing, 

as <Enter> is the shortcut for 'play'. The info panel will go green, just as for performing, but it will say 

'Playing' and the play cursor (blue line) will be moving. You need to be clear as to the difference 

between 'playing' and 'conducting'. 
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• Now change the active track: 

Switch: Main menu: Other things -> Select track. 

Keyboard: <Page down (up)>  activates track below (above).  

OR  Press 'O'  to open 'Other things' menu, then select 'Select track' 

Mouse: Click on a track  (where the notes are, not the title).  

OR  Click on 'Track' menu: 'Choose track…' 

• Now start Score conducting again: 

Switch: Open the main menu (Switch 2 or Space); select 'Perform', then 'Conduct 

Score - by segment'. 

Keyboard: Shift-A. 

 

Again notice the info panel changing to green – again remember that while you are in conducting 

mode, the normal controls don’t work. 

• Again, press Switch 2 or Space to conduct the Score, and pause sometimes to hear what is 

going on.  

The important thing to notice is that this time you are 'leading' with the bottom track (flute), and the 

guitar track is following. It is now the segments in the flute track that govern how the score is 

conducted. The segments in the flute track have been set up to be on every note, so this is what the 

guitar tries to follow, rather than the larger phrases it was playing earlier. 

Remember: the reason the bottom track is leading, is that when you started Score conducting, the 

bottom track was active. 

Finally, lets’ finish conducting, and return to ‘normal’ mode: 

• Press Switch 1 (or Enter) to stop conducting.  

Notice the info panel turns back to pink, to indicate you are back in normal operating mode.  

NB. If you used the Shift-A shortcut to start conducting, and then tried using Switch 1 to stop, you will 

have found that Switch 1 does not actually stop conducting - instead it conducts backwards!. In this 

case, you will need to press <Enter> to stop. We will investigate this further later. 

5.7.7 'Score Conducting' with a larger Score 

Finally let's load a larger score, which you might recognise. This will show one common usage of E-

Scape, especially amongst younger users: loading in a favourite piece and simply conducting it 

through for fun. This is often good 'starting' activity for a single switch user, or a beginner who is 

learning. 

• First, open the Score. You've done this before, but just to remind you: 

Switch: Open main menu (Switch 2 or Space), then select 'Open Score - from disk'… 

Keyboard: Press Ctrl-O… 

Mouse: File menu: 'Open Score (this user)'… 

• From the menu of Scores, select 'Knowing me Pt1'.  

This Score is quite a long one, and you will be asked if you want to show just part of it.  
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• Choose 'Show first section'.  

NB. If you forgot to do this, you can always 'zoom in' afterwards: 

Switch: Open main menu, then select 'Other things -> window -> 'zoom in (x2)') 

Keyboard: Press 'Z'  

Mouse: Window menu, then select 'Zoom IN' 

 

• First just try playing the Score normally:  

Switch: Open the Main menu (Switch 2 or Space), and select 'Play' 

Keyboard: <Enter> 

Mouse: Click on bottom left [>] button 

 

Now let's try conducting this Score ourselves. 

• Start Score conducting, as before  

(e.g. select 'Conduct Score' from the Perform menu, or press shift-A). 

• Conduct next segment, using Switch 2 or Space. 

• When finished, stop conducting: press Switch 1 or Enter 

Notice that the first track ('Drums') was active before you started, so that is the track you are 'leading' 

from.  You could try seeing what happens if you lead from other tracks as in 5.6.6. 

That concludes our introduction to performing. There are also many other options and variations to be 

explored later. For example, we can load a 'MIDI file' (from anywhere) into E-Scape, and can split it 

up into segments in any way we want - see 6.5.6. 



E-Scape: Getting Started Guide   © Inclusive Music, 2008                                                            48

6. Tutorials 

6.1 About the Tutorials 

In the following tutorials, you will often be given a number of methods of operating E-Scape to achieve 

the same goal. If you are a disabled user, then choose the method you are able, or want, to use. 

Alternatively, if you are a tutor and able to access E-Scape using mouse, switches and keyboards, 

then try out each of the methods in turn. This will help you to familiarise yourself with the different 

ways of accessing E-Scape. 

You can (and should) try out the 'switch' method even if you don’t have any switches connected, as 

you can use <Space> for Switch 2, and <Enter> for Switch 1, or even just press the '1', '2', and '3' 

keys for Switch 1, 2, and 3 respectively. 

Lines beginning with a bullet point (•) indicate actions. Please follow the directions closely completing 

all the actions directed before reading the next line. For example if it says:  

           ' • Press <Space> to open the menu and scroll down' 

then do this - but do not press <Enter> to select an option until you are told to, as this will often be 

directed a few lines later after some features of the menu have been explained. 

6.2 Before you start  – is everything set up on the PC correctly? 

Before starting up E-Scape, you need to make sure you are set up for MIDI (1, 2), for audio output (3), 

and any switch (4) or speech (5) facilities, if you are using them. It is also safest to quit from any other 

music software you were using. 

1. Check your MIDI instruments are set up to correspond to any soundcard you have. (See 3.1.1 for 

details). If you only have the standard instruments then these should already be set up properly. 

2. If you are using external MIDI devices, make sure any external connections are made correctly 

(See 3.1.2). 

3. Make sure your audio output (from soundcard or internal sounds) is connected to an amplifier and 

speakers and that the volume is turned up! (See 3.1.3). 

• You can test all these simply, by opening any MIDI file (.mid), which should then play using 

Windows media player. If you can hear the file playing, then your MIDI and audio settings and 

connections are set up correctly.  NB. While doing this, it is safest to not have E-Scape open - 

Windows can be fussy about having multiple MIDI applications running. 

4. If you are using switches, check they are set up correctly, so that they are assigned to the '1' '2' or 

'3' keys (See 2.2.7 and 3.2.1).  

• You can test this by opening any text file.  Then press Switch 1, followed by Switch 2 (if used). 

If you can see text '12' being typed, then your switches are set up correctly.  If you have 

Switch 3, check it types a '3' as well. 

5. If you are using a speech synthesiser, make sure it is open, and set to auto read the Windows 

clipboard. (See 2.2.8). 

• You can test this, by selecting some text, then doing 'copy' or 'cut'. If you hear the text spoken, 

then speech reading is set up correctly.  

Remember to now quit any other MIDI applications before starting E-Scape. 
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6.3 Tutorial summary 

 

Section  Tutorial name Summary  

6.4 I. Starting to compose Entering notes, and basic editing  

6.5 II. Starting to perform 'Conducting tracks'  
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6.4 Tutorial I - Starting to compose 

 

First of all (6.4.1), we will recap on what we have done so far. If you have not gone through the 

introductory look around in section 5.6 please do so now. 

After this, we will go on to look at other ways of entering and deleting notes (6.4.2), and moving the 

cursor (6.4.3). Then we look further at editing notes: selecting (6.4.4), copying (6.4.5), changing pitch 

(6.4.6), loudness (6.4.7) and duration (6.4.8), moving notes (6.4.8) and choosing an instrument 

(6.4.10). Finally we will save the score (6.4.11). 

The main focus is on switch (keyboard) control via menus and using keyboard shortcuts, but some 

mouse operations are included. 

Creating a New Score 

First, let's open a new score using switches: 

• Press Switch 2 (or Space) to open the main pop-up menu. Select 'File', then from the file 

menu then select 'New Score. 

Also try this using keyboard or mouse, if in use: 

• Keyboard: press Ctrl-N. 

• Mouse:  click on 'File' drop-down menu, and then select 'New Score'. 

Remember each new Score is called 'Unnamed', until you re-name or save it. 

6.4.1 Adding notes - a recap 

Let us briefly go through the basic operations again that were introduced in 5.6, using switches (or 

Space and Enter), as well as keyboard shortcuts.  

(a) Adding notes  

i. Adding notes using switch-operated menus 

• Open the main (pop-up) menu (press Switch 2, or Space).  

• Scroll down to the first option 'Enter notes' by pressing Switch 2 or Space once, then select it 

by pressing Switch 1 or Enter, as before. 

This opens the 'Enter notes' menu, which provides a number of options - all to do with entering notes. 

NB. From now on we will not give so much detail of the use of Switch 1 and 2 in menus - just 

remember to always use Switch 2 (or Space) to open and scroll a menu, and Switch 1 (or Enter) to 

select an item. 

• From the 'Enter notes' menu, select the first item: 'Add note - …'. 

Assuming this is a new Score, you will first be asked to choose an instrument for this track: 

• Select a group of instruments, followed by an individual instrument. 

The new note will then be entered. As this is the first note, it starts with a default pitch of A2 (the A 

below middle C, which is called C3). The note then plays itself repeatedly. 

• Press Switch 1 (or Enter) to stop play. 
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You are now in a function, which lets you repeatedly transpose and audition the note: 

• Select to make the note higher.  

You are then informed about how to operate the procedure. 

• Press Switch 1 (or Enter) to continue. 

• Press Switch 2 (Space) to transpose the note up a few times. 

• Then press Switch 1 (Enter) to stop auditioning. 

You are now asked to confirm if you have the pitch you want.  

• Select 'OK' to finish. 

The 'Enter notes' menu now reappears, as E-Scape assumes you are likely to be adding a few notes 

at one time.  

• Now add a few more notes in the same way – i.e. select 'Add note -.' and repeat the steps 

above (except this time you won't be asked to choose an instrument). 

• Finally, exit the 'Enter notes' menu by selecting 'FINISH - Entering notes', or 'CANCEL'. 

ii. Adding notes using shortcuts 

Not let's try adding some notes using the two keyboard shortcuts:  

• Press  [=] to add a note and audition; then press Switch 1 (or Enter) to stop.  

• Press  [+] to add a note without audition. 

(b) Changing step length 

Let's first recap what we did before (5.6) to add notes of different length. The 'Step Length' (displayed 

at the top right of the Score window), specifies the length (duration) of any notes which are added.  

i. Changing step length from menu 

You can change this step length using a menu: 

Switch: Open main menu (Switch 2 or Space).  Select 'Enter notes', then 'Choose step 
length…' 

Keyboard: Press 'D' 

Mouse: Open 'Note entry' menu, then select 'Set step length' 

If you scroll down this menu using switches or keyboard (i.e. not using mouse), then this menu 

automatically auditions two bars with this length if you pause on any item. After selected the step 

length you want, you will be prompted to add another note straight away (unless you used the 

mouse). 

First, let's open the 'Step Length' menu using switches: 

• Choose a new step length from the menu, using switches (see above). 

• Then select to 'add a note' when prompted.  

After going through the transpose / audition procedure, you will again return to the Enter Notes menu, 

(as you started off using Switches). 

• Add a few more notes using this menu. 
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• Exit the Enter Notes' menu, as before by selecting 'FINISH…' 

Now let's use the keyboard to open the menu: 

• Choose a different step length, again using the menu, but this time open it using the keyboard 

shortcut (see above). 

• Use Space (or cursor keys) to scroll down (or up) the menu. 

• Wait to hear the duration auditioning. 

• Again add a note when prompted. 

• Exit the 'Enter notes' menu, as before. 

Finally, try using the mouse to open the 'Step length' menu (see above). 

NB. If you use the mouse to scroll in the 'Step Length' menu, then you will not get auditioning, and will 

not be prompted afterwards to add a note. 

• Set another step length, this time using the mouse to open the menu. 

ii. Changing the Step Length using keyboard shortcuts 

You can also change the step length instantly using direct keyboard shortcuts: 

Shift-1 4 beats (Semibreve) {= US 'whole note'} 

Shift-2 2 beats (Minim)   {= US 'half note'} 

Shift-3 1 beat (Crotchet) {= US 'quarter note'} 

Shift-4 1/2 beat  (Quaver) {= US 'eighth note'} 

Shift-5 1/4 beat  (Semi quaver) {= US '16th note'} 

Shift-6  1/8 beat (Demisemiquaver) {= US '32nd note'} 

Shift-7  3 beats   (Dotted minim) {= US 'dotted half note' or '3/4 
note'} 

Shift-8  3/2 beats  (Dotted crotchet) {= US 'dotted quarter note' or '3/8 
note'} 

Shift-9  3/4 beat   (Dotted quaver) {= US 'dotted eight note' or '3/16 
note'} 

NB. These shortcuts are similar to those of Cubase. 

• Using keyboard shortcuts, change the step length trying out the various values above. 

• Each time you change the length, then go on to add a note (without audition), by pressing [+]. 

Entering notes this way is certainly far more laborious than using a MIDI keyboard, but is the only way 

if you can't use one. Once you get to know all the relevant shortcuts, it can become quite quick, so 

long as you know the note lengths you want. 

• Exercise: Enter a well-known short melodic phrase (e.g. the first line of 'Happy Birthday’ has 

notes with durations 1/2, 1/4, 3/2, 3/2, 3/2, 3 beats). If you make a mistake with a note’s 

duration, just leave it for now: we will look at editing notes in section 6.4.8. 
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(c) Deleting notes 

Let's recap (from 5.6.9) on how to delete notes. Add more notes if you run out of ones to remove. 

 

Switches: Open main menu (press Switch 2 or Space). 

Then select 'Edit', then select  'Remove'. 

Keyboard
: 

Press <Delete> or <backspace>. 

Mouse: 'Note Entry' menu:  'Delete selected notes' 

• Remove a note using switches as above. 

A 'Yes/No' menu then appears, for you to confirm removal. It is operated as expected by switches, i.e. 

Switch 2 (Space) swaps between 'yes' and 'no' options, and Switch 1 (Enter) selects the option. 

• Select 'Yes' to confirm you want to remove the note. 

Let's now use keyboard shortcuts: 

• Remove a note using keyboard shortcuts, as above. 

This time, you get a dialog box suitable for keyboard or mouse. Let's confirm we want to remove the 

note: 

• Press <Enter> to select the default 'yes' option. 

Now let's repeat this, but this time we will cancel removing the note.  

• Remove another note, again using a keyboard shortcut. 

When asked to confirm, this time select 'no' to cancel: 

• Press <Space>  (or <Tab>) to move to the 'no' button, and then press <Enter> to select. 

You can also use the mouse, via the Edit menu to delete a note, which then presents the same 

'confirm' dialog: 

• Delete a note using the mouse as above. 

6.4.2 More ways of entering and deleting notes  

Let's now look at more ways of 'step entering' notes. You can also enter notes even faster using a 

MIDI controller (e.g. keyboard) - see tutorial 6.2. 

(a) Entering notes from a menu 

So far, we have entered notes by starting off at the previous pitch, then going through a transpose / 

audition procedure, which is useful for people who are beginners to music theory, or who find using 

switches laborious. However, many people want to have the option to choose note pitches 

immediately themselves.  

We can do this in E-Scape, by choosing the pitch of a note to add from a menu. 

 

Keyboard: Press K 

Mouse: Open 'Note entry' menu, and select 'Add note - pitch chosen from menu' 
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i. Entering note pitches, using keyboard 

This gives you a menu of pitches to choose from. The default is to have 'no key' with the menu 

presenting all 12 notes of the chromatic scale (at present with sharps not flats). We will look at 

changing key and scale later in section 7.3. 

If you scroll down the menu using Space (rather than just clicking with mouse) you will hear each 

pitch auditioned. If you pause a little longer, you will then hear any existing (selected) notes in the 

track auditioning as if a new note with this pitch had been added. 

When you have selected the pitch you want, a second menu then prompts you to choose which 

octave you want including the option of the 'same as previous'.  

NB. At present this menu does not audition the Score. 

• Add several notes, choosing the pitch from menu, and using keyboard, as above. 

• Try selecting 'same as last selected note' as well as choosing another pitch.  

- Try pausing within the menu, to hear the auditioning notes, choose a pitch. 

You then are presented with a second menu, from which to select the octave of the new note, in a 

similar way.  NB. This second menu does not audition the Score at present. 

• Choose the octave from the second menu. 

• Repeat this to add a number of notes - try choosing 'same as before' as well as other octaves. 

ii. Entering note pitches using mouse 

• Now add some more notes, this time opening the menu using the mouse (see above). 

• Within the menu try scrolling down using Space (or cursor keys) - to hear the auditioning.  

 

iii. Entering note pitches using switches 

You can also enter notes in this way using switches. This is still done using the same 'Add note..' 

option, but we first need to change the 'Pitch entry mode' user setting. We will look more closely at 

this later (see 7.4), but for now let's try changing this using switches:  

To change Pitch entry mode: 

Switches: Main menu -> 'Other things' -> 'Settings' -> 'Pitch entry mode'.  

• Using switches, change the Pitch Entry mode' (as above), and select 'Pitch chosen from 

menu'. 

Now, when you select  'Add note…' from the 'Enter notes' menu, you will get a menu to 'Choose a 

pitch', rather than the previous 'audition / transpose' procedure. 

• Open the main menu (Switch 2 or Space) and select 'Add a note'. 

• Then select the pitch from the menu, again scrolling using Switch 2 (Space). Make sure you 

pause on several pitches, to hear them auditioning. 

NB1. The 'Pitch Entry mode' setting also applies to the [=] shortcut – i.e. its function changes 

depending on the 'Pitch entry mode' you have set. 

NB2. The shortcut [+] is unaffected by the 'Note Entry mode' - it still just adds a new note at the 

previous pitch and then nothing more. 
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iv. Further exercises for adding notes 

• Enter a G major arpeggio, using the pitch menu, using keyboard shortcut (K). 

• Repeat using switches. 

• Repeat using mouse. 

(b) Faster entry of notes 

Using keyboard shortcuts or mouse, you can enter notes faster if you don’t use the automatic 

audition/transpose feature.  

i. Add note and audition 

As before, it will be entered at the same pitch as the previous (selected) note, and you would then 

usually transpose it 'manually'. (See 6.4.6) 

• You can either enter a new note, and automatically audition it afterwards:  

Keyboard: = 

Mouse: 'Note entry' menu:   'Add note - same pitch as current, with audition' 

• Using the above method add some new notes. Each time, press <Enter> to stop auditioning. 

ii. Add note with no audition 

You can enter notes even faster, without having any audition: 

Keyboard: + 

Mouse: 'Note entry' menu:   'Add note - same pitch as current' 

You would then usually transpose the new note using the cursor keys. This is a very quick way of 

entering a scale or arpeggio - each note is entered at the pitch of the previous one, and then requires 

only a few presses of the up or down cursor to set its pitch. 

• Using the above method add a series of notes, each time transposing using the up / down 

cursor keys. 

NB. These two options are not available to switch users. The fastest step entry method of all is to use 

a MIDI keyboard, of course. 

 

(c) Deleting notes with the mouse 

As well as using menus and keyboard, you can also use the mouse to delete notes: 

Mouse: Click on the (drop down) 'Edit' menu, and select 'Delete selected notes'. 

• Add a number of notes, using the various methods (a, b above). 

• Then use the mouse to delete these notes. 
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6.4.3 More ways of moving the Cursor  

 

The main cursor is the red vertical line, which determines where new notes will be entered, or pasted 

in the track. Ignore the blue line which is the play cursor. 

Notice that each track maintains its own cursor position, and these commands move the step cursor 

within the active track (if you have more than one track), leaving the others alone.  

NB. You can drag in the ruler with the mouse to move the cursor in all tracks at once. 

Let's first recap what we did in section 5.6.6: press [,] (comma) to move the step cursor backwards by 

the 'snap' amount (by default the 'snap' will be 1/4 beat (semiquaver) - see 6.8.4b). 

 

(a) Moving the cursor using Shortcuts 

• Try using shortcut [,] again. 

The full shortcuts to move the cursor are:  

 

,   [comma] move backwards one snap. 

.   [full stop] move forwards one snap.  

NB. To change the snap amount, use the option in the 'move cursor' menu, 

described next. 

< move backward one bar 

> move forwards one bar 

• Try all the above shortcuts. 

 

(b) Moving the cursor using switches 

We also used switches and menus to move the step cursor - for example, you did 'Repeat go 

Backwards - by 1/4 beat (snap)', which moved the cursor back 1/4 beat each time you pressed Switch 

2 (or Space). 

• Try this again: open the main menu (Switch 2 or Space), select 'Enter notes', then select 

'Move cursor position' to open the 'Move step cursor' menu. From this menu then select 

'Repeat go Backwards - by 1/4 beat (snap)'.  

As before, you first get a reminder window of the procedure. 

• Press Switch 1 (Enter) to exit from the reminder window, and start the procedure. 

• Then press Switch 2 (Space) to move the cursor, and eventually press Switch 1 (Enter) to 

finish.  

You now go back to the 'Enter notes' menu, as this is where we came from.  

To get back to the 'Move Cursor position' menu, you can select it again from the menu, but let's first 

try out the shortcut: 

• Select 'CANCEL' (or 'finish') to exit the 'Enter notes' menu. 
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• Try using the keyboard shortcut [L] to open the 'Move cursor position' menu. 

 

Now let's explore some more of the other options in the 'Move step cursor' menu: 

 

 

Repeat go forwards 

[backwards] - by 1/4 beat 

(snap) 

Each time you press Switch 2 (or Space), the step cursor moves 

forwards [backwards] by the 'snap' amount (e.g. 1/4 beat). 

Press Switch 1 (or Enter) to finish moving. This then opens a 

further menu: 'Is this the place you want', and you can then 

select if you are at the correct position or want to move again. 

Repeat go to next bar -

forwards [backwards] 

Each time you press Switch 2 (or Space), the step cursor moves 

to the next bar forwards [backwards].  

Press Switch 1 (or Enter) to finish moving. As above, this then 

opens a further menu: 'Is this the place you want', and you can 

then select if you are at the correct position or want to move 

again. 

Go to bar… For longer Scores, you can jump the step cursor directly to a bar 

position (in 4 or 8 bar intervals). You can then use one of the 

other options to 'home in' on the exact location you want. 

NB. The largest bar position available in this menu will always 

be half a page further on than the last note in the Score. If you 

want a position much further on than this, then use the 'Scroll 

page right' option. 

Change track This option only appears in the menu if you have more than one 

track in your Score. 

MORE… This opens a further menu of options to move the cursor. 

• Try each of these options out, using switches, or shortcut to open the 'Move Cursor' menu. 
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• Finally, select 'MORE' to open a further menu with more ways of moving the cursor: 

 

Repeat go forwards 

[backwards] (to end of 

each Note) 

Each time you press Switch 2 (or Space), the step cursor moves 

forwards (backwards) to the end of the next (previous) note.  

Press Switch 1 (or Enter) to finish moving. As above, this then 

opens a further menu: 'Is this the place you want', and you can 

then select if you are at the correct position or want to move 

again. 

Go to Start of Score Scrolls back to the first page of the Score, and moves the step 

cursor to the beginning (i.e. bar 1, beat 1). 

Go to Start of page Moves the step cursor to start of the current page (it will just be 

visible at the left hand side). 

Go to End of page (last 

note) 

Moves the step cursor to the end of the last note (in the active 

track) on the current page. 

Scroll 1 page -> Right  

 [ <- Left] 

This scrolls to the next page - the step cursor will position itself 

at the left hand side of the new page.  

Repeat go forwards 

[backwards] - 1 Beat at a 

time 

Each time you press Switch 2 (or Space), the step cursor moves 

forwards (backwards) by 1 beat.  

Press Switch 1 (or Enter) to finish moving. As above, this then 

opens a further menu: 'Is this the place you want', and you can 

then select if you are at the correct position or want to move 

again. 

Add 'rest'  

(go forwards 1 beat [step 

length]) 

Moves the step cursor forward by the current 'step length'.  

If a new note is then added, this has the effect of creating a gap 

of the same duration before it. 

NB. This is not a real rest, in the score notation sense, as it is 

not a musical object, which can be moved or inserted - but 

simply a gap where no notes are currently. 

Set snap amount Opens a further menu, for you to select a 'snap' length - this is 

the smallest duration which notes (or the cursor) can move by. 

For example, you could select a larger snap for a beginner. 

• Try each option. The first item (Repeat go to end of note) is actually a routine for selecting 

notes, using the fact that the step cursor moves automatically to the end of each selected note 

(you will have noticed this already when you added notes). If the position you want is at the 

end of a note (e.g. if you wanted to add a note straight after a previous one), this will often be 

the quickest way of getting there. See 'Selecting notes' (6.4.4) for ways of doing this. 

 

(c) Moving the cursor using mouse 

Although we are mainly focusing in this guide on using switches or keyboard, it is worth showing an 

example of using the drop-down menus (at the top of the Score window) to achieve the same ends. 

These can be operated with the mouse, or using the keyboard via the usual Windows <Alt> key 

shortcuts (e.g. Alt-N opens the 'Note Entry' drop -down menu). 
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For example, to repeatedly move the cursor back to the previous bar: 

• Open the 'Note Entry' drop down menu, then select 'Move cursor' then 'Repeat go to next Bar - 

backwards': 

 

• You can also click or drag with the mouse in the bottom ruler to move the step cursor. 

(d) Exercises: entering notes and moving the step cursor 

i. Do the following four operations - using switches (or Space and Enter) only: 

• (1) Enter a major triad on C major triad at position bar 2, beat 3. 

• (2) Scroll forwards and enter a C major arpeggio with gaps between each note (i.e. with 

staccato effect). 

• (3) Go to the start of the Score (bar 1, beat 1) and enter another C major arpeggio, but this 

time with the notes overlapping (i.e. with legato effect). 

• (4) Enter another chord, this time at bar 15, beat 2-1/2. 

ii. If able to use keyboard: 

• Open a new Score - see start of this section 6.4. 

• Now repeat the above operations 1-4, using keyboard only. 

iii. If able to use mouse: 

• Open another new Score, as before. 

• Finally, repeat the above operations 1-4, using mouse only. 
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6.4.4 Selecting notes 

You can use the mouse as usual to select notes in E-Scape by clicking on them, shift-clicking, or 

drawing round them, but you can also use switches and keyboard shortcuts. 

(a) Selecting notes via switches 

Make sure you have a number of notes in your Score before starting. First we'll select a single note 

using switches, then go on to select a block of notes. 

i. Selecting a single note using switches 

This is done by stepping through the notes, starting at the current note. Let's step forwards - the most 

common option. First we start the procedure:  

• Open the main menu (Switch 2 or Space), then select 'Edit' (to open the 'Edit notes' menu), 

and finally select 'Choose notes to edit'. 

This opens a further menu: 'Select one or more notes': 

• Select the third item: 'Select a note - forwards…' 

You are then given a reminder of what to do: 

- press Switch 2 (or Space) to step through notes (going forwards).  

- press Switch 1 (or Enter) to stop, and get further options.  

NB. The exact wording depends on if you are using the keyboard or switches. 

• First, press Switch 1 (Enter) to continue with the procedure.  

• Press Switch 2 (or Space) to select the next note.  

• If in use, try pressing Switch 3 (or <Left cursor>) to select the previous note. 

• Repeatedly press Switch 2 (or Space) to select the next note, and keep going past the last 

note. 

Notice that you keep cycling round the notes in the current page (at the moment, probably the only 

page you have anyway). There are further options for selecting notes on other pages (see 6.6). 

• Then press Switch 1 (Enter) to finish selecting. 

You are now given a further menu: 'Is this the note you want', which has more options - you can: 

- select 'OK' to confirm this is the note you want, or  

- correct it by moving forwards or backwards one note, or  

- start the procedure again. 

• Select 'Move back one note'. 

The previous note is selected and again you get the 'confirm' menu. 

• This time, select 'OK'. 

You now get the 'Select one or more notes' menu back again. This lets you select multiple notes (see 

below), but if as we now have the note you want, we will just confirm OK: 

• From the 'Select one or more notes' menu, select 'OK [Finished selection]. 
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Now we are back at the 'Edit notes' menu again, as E-Scape assumes you want to do something with 

the selected note. This is an example of E-Scape trying to save work (i.e. reduce the number of 

switch presses) for a switch user. 

• For now, select 'Cancel'.    

Hint: To scroll straight to the bottom item in a menu, you can press Switch 3 (if in use), or press <Up 

cursor> if using keyboard. 

You can also step through the notes backwards (see 6.4.3). This is useful if you already have a note 

selected which is a long way forwards in the track, and want to select one a little further back. 

ii. Selecting a block of notes using switches 

Let's now select a number of notes together to form a 'block'. The simplest way of doing this is to start 

a guided 'procedure' which guides you through the process: you begin by selecting the first note of the 

block, then stepping through the subsequent notes to add to it. This assumes you are selecting notes, 

going forwards from (i.e. to the right of) where you are - again there are other options if you want to go 

the other way (see 6.4.3). 

Let's start the 'select block' procedure:  

• Press Switch 2 (or Space) to open the main menu.  

• Then select 'Edit', then 'Choose notes to edit', then select the first item: 'Guided' select Block 

[procedure]'. 

You are first given a prompt of what is to happen (i.e. you will first select the first note of the block, 

then step through notes to add to the block). 

• Press Switch 1 (Enter) to continue with the procedure. 

To select the first note of the block is exactly the same procedure as in (a) above.  

(1) First, you get another prompt reminding you what to do: 

- press switch 2 (Space) to select the next note (going forwards);  

- press Switch 1 (Enter) to stop;  

- select 'OK' for the menu if and when you have the correct note. 

• Press Switch 1 (Enter) to continue. 

• Repeatedly press Switch 2 (Space) to select the next note. 

• Press Switch 1 (Enter) to finish. 

• Select 'OK' from the 'Is this the note you want' menu. 

(2) Having now selected the first note of the block, you are again given a prompt with what to do next 

- i.e. to step through notes, which are added to the block. 

• Press Switch 1 (Enter) to continue. 

• Now, repeatedly press Switch 2 (Space) to add notes to the block. 

• If in use, try pressing Switch 3 (or <Left cursor>) to delete notes from the block. 

• Press Switch 1 (Enter) to finish. 
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You are now given a further confirmation menu ('Is this the block of notes you want') with more 

options:  

- you can select 'OK' to confirm this is the block you want, or  

- correct it by adding or removing a note, or  

- start the procedure again. 

• Select 'Remove the last note'. 

The last note is removed from the block (i.e. becomes 'unselected'), and again you get the 

confirmation menu. 

• This time, select 'OK'. 

Again we return automatically to the 'Edit' menu, where you can choose various editing options to 

perform on the selected block of notes (see 6.4.5). 

• For now, select 'Cancel'.    

NB. For further options for selecting notes (e.g. to go backwards) see 6.4.3. 

(b) Selecting notes via keyboard 

As well as using the keyboard to operate the menu options above (using Space and Enter), you can 

also use shortcuts directly: 

 i. Selecting a single note using keyboard 

As in most music software, you can press <Left cursor> or <Right cursor> to select notes. 

• Repeatedly press <Right cursor> and  <Left cursor> to select a note. 

ii. Selecting a block of notes using keyboard 

As in most music software, you can hold down the <shift> key while pressing <Left cursor> or <Right 

cursor> to select multiple notes. 

• Repeatedly press shift- <Right cursor> to add notes to right of those already selected. 

• Repeatedly press shift- <Left cursor> to add notes to left of those already selected. 

NB. At present there is no shortcut to remove selected notes from a block. 

6.4.5 Editing: copying notes 

Let's now start doing some editing of notes we put in earlier copying some notes, firstly (a) via a 

simple 'guided' procedure, then (b) using other, more flexible, copying options. 

• Make sure you have a Score with plenty of notes. If not, add some more - see 5.6.7. 

(a) Copying using the 'Guided copy' procedure 

The 'Guided Copy' procedure is the simplest way of copying notes within a track, as it prompts you at 

each stage or the operation. This is useful for people new to computer software, for whom the 

successive operations of selecting, copying, moving the cursor and pasting may not necessarily be 

intuitive. It also helps reduce work (i.e. reduce the number of switch presses needed) for users who 

find operating switches laborious. 
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• Open the Copy menu: 

Switch: Open Main menu (Space or Switch 2), and select 'Copy' 

Keyboard: Press 'C' 

• Select the first option: 'Guided Copy…[procedure]'. 

This then guides you through three steps to copy and paste notes within the current track: 

(1) First, you are asked to select the notes you want to copy. You can copy all the notes in the track 

(on the visible page that is), or use the notes which are already selected, or select a new block of 

notes as you did earlier.  Let's do the simplest option for now: 

• Select 'Copy ALL notes' 

The selected notes are now automatically copied to the clipboard. 

(2) Next you are asked to move the step cursor to the position where you want to paste the notes. 

This is the same as when you moved the step cursor previously (see 6.4.3), except you also have the 

option to select 'HERE' if the step cursor is already at the desired paste position.  

• Select 'Go forwards - by BEATS. 

Then move the step cursor as before: 

• Press Switch 1 (Enter) to continue from the instruction window. 

• Press Switch 2 (Space) a few times to move the step cursor towards the right. 

• Press Switch 1 (Enter) to finish. 

(3) You then get a menu to confirm you are in the right position, correct it or move again. 

• Select 'OK - Here'. 

After confirming the step position you want, the notes will then be automatically pasted in, starting at 

that position. 

(b) Copying 'manually' using the Copy menu 

Now let's use some of the other, more flexible, options to copy and paste notes: 

• Open the Copy menu 

i. First select some notes to copy: 

• Select the second option 'Select notes'. 

• In the Select one or more notes' menu, for simplicity select the first option:  'Guided select 

Block [procedure]', and follow through the process as you did in section 6.4.4. This will result 

in you selecting a block of notes, and the 'Copy cut or paste' menu will now reappear. 

ii. Next we need to copy the selected notes to the clipboard: 

• From the 'Copy cut or paste' menu, select 'Copy'. The bottom info panel tells you the notes 

have been copied to the clipboard, and again the 'Copy…' menu reappears. 

iii. Now we need to choose where to paste the notes: 

• Select the third item: 'Choose cursor position', which opens the same 'Move cursor position' 

menu you have seen before in 6.4.3.  
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• From the 'Choose cursor position' menu, use any of the options to choose a new cursor 

position.  

NB. If you have more than one track in your Score, you can also change track from here. 

After confirming 'OK' when asked 'is this is the place you want', the 'Copy cut or paste' menu will once 

more reappear. 

iv. Finally we need to do a 'paste': 

• From the 'Copy cut or paste' menu, select 'Paste' (or if feeling adventurous 'Paste MORE'). 

NB. Once notes have been pasted, the 'Copy cut or paste' menu does not reappear again, as E-

Scape knows you have now completed a copy and paste operation. 

6.4.6 Editing: changing notes' pitch 

Earlier we changed the pitch as part of the process of entering a note - let's now look at changing 

pitch of existing notes.  

There are two main ways of changing pitch: (a) one step at a time, or (b) using a menu of intervals. 

Method (a) is far easier for a beginner, while method (b) is better for someone who knows, or is 

learning, more about musical terms and theory. 

(a) Changing pitch one step at a time 

There are two ways of doing this, using a switch-operated procedure, or using keyboard shortcuts. 

i. Using change pitch / audition procedure 

Using the pop up menus via switches or keyboard, you can start a procedure similar to that you have 

seen before, in which you can make the note one step lower (or higher) each time. Switch 2 (or 

Space) is pressed and automatically auditions the notes each time.  

First make sure you have a few notes in the track. 

• Select a note towards the end (see 6.4.4).  

Now let's transpose the selected note up a fifth: 

• Press Switch 2 (Space) to open the main menu and scroll down, and select 'Edit' to open the 

'Edit notes' menu. 

• Then select the second item: 'Repeat - make pitch higher'. 

An info window then pops up, reminding you what to do during the procedure. 

• Press Switch 1 (or Enter) to continue from the info window. 

You are now within a 'transpose and audition' procedure: 

• Press Switch 2 (Space) to transpose up one step (e.g. a semitone).  

• Pause and the note will audition the note in context - i.e. playing a few notes before and after 

as well. 

• If in use, you can also press Switch 3 (or Up / Down cursor) to transpose the other way. 

• Continue transposing the note up, and pausing sometimes to hear it. 

• When you have gone up a fifth, press Switch 1 (or Enter) to stop the process. 
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You are now presented with a second menu ('Is this the pitch you want?') confirming you are 'OK' with 

the pitch you have got to. If not, you can choose to correct the pitch up or down one, or start again. 

• This time, select 'OK' to finish. 

• Now repeat the procedure a number of times: 

- Each time try a different option from the second menu.  

- Also transpose down as well as up. 

- If you can use the keyboard, try starting the procedure using the shortcut 'E' to open the 
edit menu, again selecting 'Make note lower (higher)'. 

You can also use the mouse to start this procedure: Edit menu:  Change pitch -> 'Repeat Pitch down 

(up) - with audition'. However, the procedure is really designed for switch or keyboard users, so you 

will still need to use Space and Enter once it is under way. 

ii. Using direct keyboard  shortcut (no audition) 

Using the keyboard shortcuts, you can also change pitch quickly without any auditioning, by pressing 

<Up cursor> or <Down cursor>. 

• Select various notes using <Left cursor>, <Right cursor> and <Shift> keys.  

• Then try changing their pitch up and down using <Up cursor> and <Down cursor>. 

(b) Using menu of intervals 

If you know what interval you want to change (transpose) the pitch by, you can choose this from a 

menu. There are two menu options to make pitch higher or lower: 

Switches: Press switch 2 (or Space) for Main menu.  

Select 'Edit'. 

Select 'MORE edit options…' 

Select 'Make pitch Higher [Lower] (menu)…' 

Keyboard: Press shortcut <shift- E>  to open the 'MORE Edit options' menu.  

Select 'Make pitch Higher [Lower] (menu)…'   

 

• Having selected one or more notes, make the pitch higher and lower by various intervals, 

using menus, as above: 

- transpose pitch up by 5th 

- transpose pitch up by 4th 

- transpose pitch down by an octave 

- play again to check pitches are back where they started 

NB. If using mouse, all the above options are also available: Open the 'Edit' (drop down) menu, then 

select 'Change pitch' -> … 

(c) Exercise: entering notes, editing pitches and copying 

 Let's now start with a new Score, and copy to make a four bar tune. 

• Open a new Score, as at the start of this chapter. 

• Enter notes, as before (see 6.4.2) for one bar. 
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• Copy all these notes and paste at the start of bar 2. 

• Change the pitch of the copied notes. 

• Then copy all the notes except the first one, and paste at bar 4, beat 2. 

• Repeat the above steps a few times, each time with a new Score. Try to choose the quickest 

way of doing things - e.g. check if the notes you want are already selected, or the step cursor 

already in the right position - if so you can select that menu option (e.g. 'HERE') to save time. 

 

Next, we will look at ways of editing two other aspects of notes: their 'loudness' and duration. 

6.4.7 Editing: changing the loudness of notes 

In E-Scape, 'loudness' is a simplified form of MIDI note 'velocity'. The aim is to avoid presenting the 

user with too much technical terminology. 

There are 12 levels, which map to the 127 MIDI 'velocity' levels (with low velocity being ‘quieter’ then 

higher velocity: 

E-Scape loudness 1 = MIDI velocity 7 E-Scape loudness 7 = MIDI velocity 67 

E-Scape loudness 2 = MIDI velocity 17 E-Scape loudness 8 = MIDI velocity 77 

E-Scape loudness 3 = MIDI velocity 27 E-Scape loudness 9 = MIDI velocity 87 

E-Scape loudness 4 = MIDI velocity 37 E-Scape loudness 10 = MIDI velocity 97 

E-Scape loudness 5 = MIDI velocity 47 E-Scape loudness 11 = MIDI velocity 107 

E-Scape loudness 6 = MIDI velocity 57 E-Scape loudness 12 = MIDI velocity 127 

 

NB1. MIDI files, when loaded in, retain their original MIDI velocity, but the nearest available 'loudness' 

is displayed in E-Scape. 

NB2. Technical note: MIDI experts will know that the MIDI velocity parameter is not necessarily 

mapped to loudness level, and can affect many other parameters instead or as well as mere 

loudness. Some synthesisers can even be programmed to make part or all of the sound quieter with 

increasing MIDI velocity values! However, it was felt that 'loudness' would be most intelligible for most 

E-Scape users. 

At present, E-Scape just lets you change the loudness of selected notes by a specified amount. This 

means that relationships between notes are maintained. More options will follow in future versions. 

This is done from two menus, one for louder, one for softer.  

To open the menu to make notes louder: 

Switch: Main menu: Edit -> 'Make louder' 

Keyboard: V 

Mouse: Edit menu: Expression -> 'Increase note loudness by…' 

To open the menu to make notes softer: 

Switch: Main menu: Edit -> 'Make softer' 

Keyboard: shift-V 

Mouse: Edit menu: Expression -> 'Decrease note loudness by…' 

• Select some notes, and then make them louder. 
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• Play the Score (see 5.7.3). Then make the notes softer by the same amount, and play again. 

6.4.8 Editing: changing the duration of notes 

So far we have been choosing a 'step length', which specifies length of notes (their duration) when 

they are entered. However, we will often want to change the duration of notes later when editing the 

music, and E-Scape has a number of ways of doing this.  

Here, we will use the simplest method, where you select the notes you want then select a new 

duration from a menu.  

 To open the 'Change Duration' menu: 

Switch: Open Main menu (Switch 2 or Space), and select 'Edit'. 

From the 'Edit notes' menu, select 'Change Duration'. 

Keyboard: Press E to open 'Edit notes' menu, then select 'Change Duration'. 

Mouse: Click on 'Edit' menu -> Duration -> 'Set duration of selected notes' 

 

This opens a menu of durations, from which you select the one you want.  

If you use switches or keyboard (i.e. not mouse) to scroll down this menu, then (as for the 'step length' 

menu) each duration will audition itself with a 2 bar sample. 

• Open the 'Change duration' menu, and scroll down using switches or keyboard. Pause to 

audition each duration, then select one. 

6.4.9 Editing: moving notes 

(a) Repeatedly moving (by snap) with audition 

So far we have determined the position in time of notes using the step cursor position when they are 

entered. Let's now try moving existing notes backwards and forwards in time. 

First let's use a procedure to move notes a small amount each time, and automatically audition what it 

sounds like each time. It is very similar to the changing pitch procedure, as in 6.4.6a above.  

The 'small amount' is called the 'snap', and by default is set to a quarter of a beat, i.e. a semiquaver. 

We'll try changing this in a moment. First, let's move a note forwards, i.e. make it start later in time. 

First make sure you have a few notes in the track, and one is selected (see 6.4.4). To start the 

procedure: 

• Press Switch 2 (Space) to open the main menu and scroll down, and select 'Edit' to open the 

edit menu. Then select 'Repeat - Move note forwards - by 1/4 beat'. 

You then get information about what to do during the procedure, which is similar to ones you have 

used earlier. 

• Press Switch 1 (or Enter) to continue from the info window.  

You are now within a 'move notes / audition' procedure: 

• Press Switch 2 (Space) to move forward one snap (e.g. 1/4 beat).  

• Pause (i.e. do nothing) to audition the note in context - i.e. playing a few notes before and after 

as well. 

• If in use, you can also press Switch 3 to move the other way. 
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• Continue moving the note, and pausing sometimes to hear it. 

• When you have gone forwards a few jumps, press Switch 1 (or Enter) to stop the process. 

• Now repeat the procedure (the steps above), this time going backwards. 

You can also use the mouse to start this procedure: Edit menu:  'Move notes' -> 'Repeat move 

forwards (backwards) by snap - with audition'. However, the procedure is really designed for switch 

users, so you still need to use Space and Enter once it is under way. 

 

(b) Changing the 'snap' amount 

We have so far been moving notes by the 'snap' duration, e.g. 1/4 beat. The 'snap' governs the 

smallest change you can make to the positions of notes or the step cursor. You can change this to 

suit how accurate or easy you want to be. Each Score can have it's own snap amount, although this is 

not currently saved to disk with the Score. 

To change this using switch or keyboard, select 'Set snap amount' from either the 'Move notes' or 

'Move step cursor' menu you have already used. Using the mouse, select 'Set snap' from the 'Score' 

menu. In full: 

 

Switch: Open main menu (Switch 2 or Space), then select: 'Edit -> 'MORE 

edit options' -> 'Move notes (menu)' -> 'Set snap amount' 

Keyboard: M  (Move notes menu) -> 'Set snap amount'   

Mouse: Score menu:  'set snap'… 

• Try setting the snap amount to 1/2 beat or 1/8 beat. 

Notice the time ruler changing to reflect the new snap value. 

• Then try moving notes again, as in (a) above. 

(c) Moving notes by other distances 

You can also move notes backwards and forwards in other ways: 

i.  to the beginning of the next or previous bar. 

ii. by one beat forwards or backwards. 

iii. by a single snap, without auditioning. 

Let's look at these in more detail: 

i. Move notes to next bar forwards [backwards] 

 

Switch: Open main menu (Switch 2 or Space), then select: 'Edit', then -> 

'MORE edit options' -> 'Move notes (menu) -> 'Move to next bar 

forwards [backwards]' 

Keyboard: Alt-shift- <Right [Left] cursor> 

Mouse: Edit menu: Move notes -> Move forwards [backwards] to next bar' 

The selected notes will then move to the start of the next (or previous) bar.  

If using switches or keyboard, the 'Move notes' menu then re-appears. 
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ii. Move notes forwards [backwards] by one beat 

Switch: Open main menu (Switch 2 or Space), then select: 'Edit', then -> 

'MORE edit options' -> 'Move notes (menu) -> 'Move forwards 

[backwards] one beat' 

Keyboard: Press M  to open 'Move notes' menu.  

Then select  'Move forwards [backwards] one beat' 

Mouse: Edit menu: Move notes -> Move forwards [backwards] one beat' 

The selected notes will then move one beat forwards or backwards from their present position.  

If using switches or keyboard, the 'Move notes' menu then re-appears. 

iii. Move notes forwards [backwards] one 'snap' (e.g. 1/4 beat)  

Switch: Open main menu (Switch 2 or Space), then select: 'Edit', then -> 

'MORE edit options' -> 'Move notes (menu) -> 'Move forwards 

[backwards] 1/4 beat (snap)' 

Keyboard: Alt- <Right (Left) cursor> 

Mouse: Edit menu: Move notes -> Move Forwards (Backwards) by 1/4 

beat (Snap)' 

The selected notes will then move one 'snap' (e.g. a 1/4 beat) forwards or backwards from their 

present position. This is similar to the repeat move procedure in (a) above, except the notes just more 

once, then return to the menu. 

NB. If you used switches or keyboard, the 'Move notes' menu will then re-appear after each move. 

Select 'FINISH move'. 

• Select a single note and try each of the above options. 

• Select 'FINISH move'. 

• Now select a block of notes, and again try moving them using the above options in a number 

of ways. 

• Finally, again select 'FINISH move' to exit the menu and finish. 

6.4.10 Changing the Instrument sound 

The present version of E-Scape makes sound using MIDI instruments (and changes the sound by 

sending MIDI program change messages to whatever MIDI sampler or synthesiser it is connected to). 

You don’t need to know anything about MIDI however, so long as your PC has the standard windows 

MIDI setup - see 6.2. 

When you opened a new Score previously, you were prompted to choose an instrument sound for the 

track. You can also change this Instrument at any time. 

You first choose a type of sound  (i.e. a family of instruments) from a menu: 

Switch: Main menu: 'Other things' -> 'Change Instrument'. 

Keyboard: Press 'I'  

Mouse: Track menu: 'Choose Instrument - with audition' 
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• Using Switch 2 or Space, open the menu to select a sound type (instrument family). 

• Pause on an item, to audition the sound type. 

Each sound type contains eight instruments, and each will be auditioned in turn. 

If you have a note selected (and there is at least one in the track), then the audition will play the 

selected note(s) in context. Otherwise, you will just hear three notes an octave apart. 

• Also try scrolling down (Switch 2 or Space) to interrupt auditioning. 

• Select a sound type (Switch 1 or Enter). 

A second menu now lets you choose one sound from the group, again auditioning it if you pause on 

the menu. If you decide none of these sounds is what you want, you can also 'GO BACK' to the sound 

types menu (bottom item). 

• Scroll, audition, then select one sound. 

NB. By default, the number and names of the sounds default to the 128 'General MIDI' instruments, 

i.e. you have 16 groups of 8 sounds. 

6.4.11 Saving your score 

Once you have used all the previous activities to create a tune, you will often want to save it for 

another occasion. Each 'User' of E-Scape has their own file area, which they can save to, and load 

from. e.g. the Score files for user 'Jane', will be stored in: 

c:\ Program Files \ E-Scape \ Users \ User - Jane \ Scores for user Jane \ 

Doing this also means that a user does not need to access the Windows file system, or use the 

Windows file dialog (the small window in which you navigate around the files and folders), which is not 

easily switch-controllable.  

For mouse and keyboard users, there are many other options to save to and load from anywhere, on 

internal or external disks, using a more standard file selector dialog.  

For this tutorial, we will just save in the simplest way, to our own user area. 

• Using Switch 2 (Space), open main menu, then select 'File', then 'Save' 

In each case you will be prompted for a name for the Score file, if you haven’t already got one.  

If you used the keyboard or mouse to save, then you will get a normal text entry dialog. If you used 

switches to save, you will get a letter grid to enter the name - see 5.3. 

If the Score already has a name then it will be saved immediately, and a message telling you this will 

briefly appear in the bottom info panel. 

• If keyboard is in use, also try pressing Ctrl-S to save, or you can press 'F' for the pop-up File 

menu, then select 'Save'. 

• If in use, also try clicking with mouse on the 'File' menu, then select 'Save Score (this user)'. 

This concludes this tutorial. You should now have a basic knowledge of entering and editing notes. In 

later tutorials we will expand on this, for example adding more tracks, doing more complex editing and 

copying operations, scrolling and zooming windows, more options for locating step cursor and 

recording live, more user customising and settings, and control via MIDI.  
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6.5 Tutorial II - Starting Performing: 'Conducting tracks' 

In this tutorial we will look in more depth at the ways an individual E-Scape user can set up and 

conduct music live, using switches and keyboard, and how to record and save a live performance. 

In a future tutorial, we will look at using E-Scape at the centre of a performance group with multiple 

performers, using MIDI control. 

NB. When performing, in some cases the effect of using PC keyboard and using switches are slightly 

different. If you don’t have a switch interface, you can still try the effect of using switches, by simply 

pressing the '1', '2' and '3' keys on the PC keyboard. 

6.5.1 Before you start 

If you have time, it is also worth getting a grasp of the concepts behind performing with switches - see  

the paper 'Using Music Performance Software with Flexible Control Interfaces for Live Performance 

by Disabled Musicians', on the www.DrakeOnline.org website, in the 'Instruments' section"  

This tutorial assumes you have already worked through the 'First steps with Performing' tutorial in 

section 5.7, although we will start off here with similar activities, in more detail. 

6.5.2 Changing user and loading Scores  

The example Scores we will use are stored within the 'Demo' user's file area. 

If you are already user 'Demo' you can skip the next two steps, otherwise you need to change the 

User to 'Demo'. Full details of this were covered in tutorial 5.7.2, but in summary: 

• Open menu of users. 

Switches: Press Switch 2 (Space) to open main menu, and select 'Other things'. 

Then select 'Settings' to open the Settings menu, and select 'Change to 

ANOTHER User'. 

Keyboard: Press S to open Settings menu, and select 'Change to ANOTHER User' 

Mouse: Click on 'User / set-up' menu, then select 'Users' -> 'Change to ANOTHER 

user'.  

• From the menu select the user 'Demo'.  

Now, assuming you are user 'Demo', we will now load the Score 'Early example 1': 

• First open the Score menu:  

Switches: Press Switch 2 (or Space) to open main menu, then select 'File'. 

From the File menu, select 'Open Score' 

Keyboard: Press  Ctrl-O 

Mouse: Click on File menu, then select 'Open Score' 

Files are shown in reverse date order, i.e. with most recent files at the top. 

• Select 'Early example 1'  (it should be at or near the top of the menu). 

NB. While loading, if you are asked if you want to load settings with the Score - say 'Yes'. 
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6.5.3 'Conduct tracks by segment' 

(a) Conducting using Switches 

Let's start 'Conducting Tracks', by using Switches: 

• Open the main menu (Switch 2 or Space), then select 'Perform', then 'Conduct tracks (by 

segment)'. 

If by any chance the menu (or in the info panel, once conducting) doesn’t say 'by segment'  - then 

your conducting mode is set wrong. If so, in the Perform menu, select:  'Conducting set up' -> Track 

conducting mode -> 'by segment'. See 6.5.4. 

You are now performing - 'conducting tracks by segments'. But before pressing anything further, have 

a look at the bottom information panel: 

- Before proceeding, check that this has changed colour to green. If not, then you have not started 

conducting properly (i.e. are still in 'normal' mode) - so go back to the previous step before 

continuing. 

- The green colour confirms that you in 'conducting' mode - remember that you will need to stop 

conducting (press Switch 1, <Enter> or 'A') and return to normal mode before you can operate the 

mouse, menus or normal shortcuts.  

NB. The mouse is not used while conducting, and you should not try to operate it. If you want to do 

something else with the mouse, you first need to stop conducting (see above). 

- The panel reminds you which controls (keys or switches) do what, in this performing mode.  

While conducting, be careful not to press <Enter> or Switch 1, or 'A', as this will stop conducting. If 

you do, then just start conducting again, as above. 

Let's now do some 'performing'.  

• Press Switch 2 (or Space) to play ('trigger') the first segment in the top  track ('Melody 1').  

You will now hear a 4 note phrase, and can see a bold outline around these four notes.  

 

 

This is a 'segment'. Each track is split into multiple segments, and in this example you are triggering 

segments in one track at a time. This is the 'active track', indicated by the coloured title. In this 

example, the top track [named 'Melody 1 (seg=4beats)'] is active to start with. 

• Now press Switch 2 (Space) again, a few times - start slowly and pause, then try it more 

quickly. You will see that you can either interrupt a segment, or wait for it to finish. You can try 

to play the track exactly as written, or vary the timing to do you own version. 
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• If in use, press Switch 3  (or just '3') to change the 'active track' to be the middle one [named 

'Melody 2 (seg= 1 beat)']. 

NB. If you have set up E-Scape to use a single switch (Switch 1), you can still change track once you 

get to the end, as a menu will pop up to ask you what you want to do. 

• Now continue to press Switch 2 (Space) to play segments in the middle track. 

Notice how this track is split up differently in this example: each segment is just one beat long. Most 

segments just contain one note, but the sixth segment, for example, consists of two shorter notes. 

This track will therefore need faster switch pressing to conduct it 'as composed' (i.e. so it sounds 

roughly as if it is playing normally) compared with the top track, actually four time faster. 

• If in use, again press Switch 3 to make the bottom track active ('Bass').  

Again notice this track has different segments - this time every 2 beats, so that each 2 beat (minim) 

note has it's own segment. 

Using E-Scape, several players can perform together, each conducting their own track at the same 

time, but in this tutorial we are concentrating on a single performer being able to conduct and change 

the material they are conducting. 

In this example, the three tracks do actually form a piece if you play the Score normally. But for 

performing, you need to think of each track more as a palette of musical material which can be 

accessed sequentially by a performer.  

For example, you could have: 

- a set of chords in one track. 

- the same set of chords in the next track but transposed up by a fifth. 

- a third track with single notes, plus some fast ornaments within a segment in a scale or 

arpeggio  for a solo line, using a different instrument. 

-a fourth track the same as the third, but with a different instrument, or different volume, or 

key. 

E-Scape also let's you split up tracks into segments yourself - see 6.5.6. 

• Continue conducting with Switch 2, and pressing Switch 3 to change the active track. When 

you get to the bottom, the active track then goes back round to the top track. * Do NOT press 

Switch 1 yet. 

• Try the up and down cursor keys:  

<Down cursor> goes down one track (like Switch 3) 

<Up cursor> goes up one track. 

<Right cursor> conducts (like Switch 2 or Space). 

<Left cursor> conducts backwards - see (b) below…. 

(b) Using Switch 1 while conducting 

• Press Switch 1 to see what happens - one of two things: 

It will either conduct backwards, or finish conducting (info panel returns to pink). 

Let's look more closely at the operation of Switch 1: 
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When you started conducting in (a) above, you were asked to open the main menu, using Switch 2 or 

Space. If you did use Switch 2 (i.e. did not use the Spacebar), then E-Scape assumes you are a 

switch user operating E-Scape. Hence Switch 1 acts as normal to finish the operation, i.e. to stop 

conducting. However, if instead you used the keyboard (i.e. pressed Spacebar) to operate the menus, 

then E-Scape assumes that the keyboard can be used, and hence you can press <Enter> to stop 

(often, a switch-user will be performing using switches, but an assistant can help to start and stop 

using the keyboard). This means that while performing, Switch 1 can be utilised for more conducting 

functions. In this case it is used to conduct backwards. 

NB. If you are a switch user, you can also use Switch 1 to conduct backwards - see 7.5. 

• If you haven’t already, now stop conducting, by pressing <Enter> or 'A' again. 

You should now have returned to 'normal' mode, and notice that the info panel returns to pink. 

Switches and keys will now operate to open menus etc as normal. 

 

(c) Starting conducting using keyboard 

If you can use the keyboard, let's now start conducting again, but this time using the keyboard 

shortcut: 'A' to start, and use all switches and cursor keys. 

• Press 'A' to start conducting again. 

Check the info panel has gone green, to confirm you are in a performing mode. 

NB. If you press 'A' a second time you will stop conducting. If you don’t have the PC keyboard repeat 

set to 'off' as recommended (see 3.2.2), you might do this accidentally! 

• Again try the effect of Switches 1, 2 and 3. Check that Switch 1 conducts backwards. 

Remember, if you don’t have a switch interface, you can still try this, by simply pressing the '1', '2' and 

'3' keys on the PC keyboard.  

• If in use, try using <Left cursor> to conduct backwards. 

• Try operating using all available controls: all four cursor keys and <Space>, as well as 

switches 1, 2, 3 and 0. 

• Finally, stop conducting again, by pressing <Enter> or 'A' again. 

 

(d) Starting conducting - summary 

You can also start 'conducting tracks' using the mouse.  

Here is a summary of ways to start conducting tracks: 

 

Switches: Main menu: Perform -> 'Conduct tracks (by segment)' 

Keyboard: A             (NB. You can then press A again to stop conducting) 

Mouse: 'Perform' menu: 'Conduct tracks (by segment)'.  

In practice, for a non-switch user, the fastest way is to press 'A' to start and stop conducting. 

 



E-Scape: Getting Started Guide   © Inclusive Music, 2008                                                            75

6.5.4 Choosing or creating a user  

Next let's look at setting up some performing Scores of your own. First change the 'User' to be your 

own one, so you can save your own Scores and leave the 'Demo' user's alone.  

Back in tutorial section 5.3 you should have created a new user with your name, and now need to 

change back to it. 

If you missed out section 5.3 and don’t have a user of your own, then now is the time to create one. 

• First open the menu of users, as before: 

Switches: Press Switch 2 (Space) to open main menu, and select 'Other things'. 

Then select 'Settings' to open the Settings menu, and select 'Change to 

ANOTHER User'. 

Keyboard: Press S to open Settings menu, and select 'Change to ANOTHER User' 

Mouse: Click on 'User / set-up' menu, then select 'Users' -> 'Change to ANOTHER 

user'.  

• Either change to your own (existing) user: Select your user name from the menu. 

• Or create a new user: Select 'NEW Person', then follow the prompts, entering your name, and 

selected preferences. 

• ** IMPORTANT ** When asked if you want to close the Scores of the previous user, say 'No', 

as we want to keep these open, so we can modify and save them into our own user area. 

6.5.5 Saving Score with a new name 

Now we can save the 'Early example 1' score safely into your own area.  

Let's give it a different name so instead of using 'Save', as before, we'll use 'Save as': 

Switch: Switch 2 (space) to open main menu:  File -> Save as.. 

Keyboard: Press Ctrl-shift-S. 

Mouse: Click on File menu: 'Save other' -> 'Save Score as…' 

• Save the Score with a different name, using 'Save as', as above. 

6.5.6 Creating segments 

The segments you have been using in this Score were loaded in along with it, but you can easily set 

up your own. There are three ways of creating segments - all within the 'Create Segments' menu 

(accessed from the 'Conducting setup' menu). We will try out each one, on each of the three tracks. 

(a) Select segment size from a menu  

If the track has a regular beat, and you know how long you want your segments to be, then this is the 

most straightforward way to create segments. Simply select the length from a menu.  

Switch: Main menu: Perform -> 'conducting set-up' -> Create segments -> 

'Create segments with a chosen length’. 

Keyboard: Ctrl-P ('conducting set-up' menu) -> Create segments -> 'Create 

segments with a chosen length'… 

Mouse: 'Perform' menu:  'Conducting set-up' -> Create segments -> 'Create 

segments with a chosen length’. 
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• Select '4 bars'.  

 

 

An info window then pops up to tell you how many segments you now have, and you can also see 

some of the segments displayed in the track, behind the window. 

It also lets you know how fast you would have to press switches etc if you wanted to conduct the track 

'in time', i.e. for it to sound 'as composed' and at the same tempo as normal playback. This 

information is only useful if you (i) want to do this, and (ii) know how fast you or the performer is able 

to press. 

• Press Switch 1 (or Enter) to continue. 

NB. From now on this step will be assumed. 

• Test the new segments by starting track conducting (e.g. press 'A' or see 6.5.3 above). 

• Stop conducting (e.g. press <Enter> again or see 6.5.3 above). 

(b) Create segments by 'tapping'    

We will now try another method to create new segments. 

If the track has uneven note times, e.g. from real-time recording or a performance MIDI file, or you 

can’t see how long you want from looking at it, you can create segments by 'tapping'. This involves 

you repeatedly pressing a switch or key as you listen to the track, and E-Scape learns the segment 

divisions you want from when you pressed. 

• Making sure you have stopped conducting (info panel is pink), select the next track 'Melody 2' 

(e.g. press <Page Down> or see 6.5.5 above) before continuing. 

• Start tap learn mode: 

Switch: Main menu: Perform -> 'conducting set-up' -> 'Create segments - 

by Tapping' 

Keyboard: Ctrl-P ('conducting set-up' menu) -> 'Create segments - by Tapping' 

Mouse: 'Perform' menu:  'Conducting set-up' -> 'Create segments - by 

Tapping' 

You are now prompted to press Switch 2 (or Space) to start the track playing. While the track is 

playing, every time you press Switch 2 or Space, it is remembered and used to create a segment 

starting at that time. 

• Press Switch 2 (or Space) to start the track and 'tap' along, while it plays. 



E-Scape: Getting Started Guide   © Inclusive Music, 2008                                                            77

• Press Switch 1 to stop or wait for the track to end. 

• Again, you are informed of the segments created. 

(c) Create segments using selected notes 'example' 

• Again, making sure you have stopped conducting (info panel is pink), select the next track 

Bass' (e.g. press <Page Down> or see 6.5.5 above) before continuing. 

If the Score has a regular beat, the easiest way to specify segment length is 'by example' - i.e. you 

select notes (anywhere in the track) which have the duration you want. 

• First, select several notes (e.g. shift-<Right cursor>, or see 6.4.4) you want to use as a 

'template' length for creating segments.  

• Then select to create segments, using the selected notes as a template: 

Switch: Main menu: Perform -> 'Conducting set-up' -> 'Create segments' -> 

'Create segments using duration of selected notes' 

Keyboard: Q 

Mouse: 'Perform' menu:  'Conducting set-up' -> 'Create segments' -> 

'Create segments using duration of selected notes' 

You are then asked to confirm this is what you want to do. 

(d) Choosing which method for creating segments 

If the tempo is regular, then of all the above methods, the quickest way (if using the keyboard) is 

method (b), i.e: 

i. Select the notes you want to give the length of a segment (drawing with mouse, or pressing shift-

right cursor) 

ii. Press shortcut Q to create segments of this length. 

E.g. if you wanted to make the whole track a single segment, so it can be triggered as one event, then 

simply select all the notes (e.g. shortcut Ctrl-A), then press Q.  

If using switches, method (a) via menu is probably easier, if you know what length you want, 

otherwise try using method (c). 

However, if the tempo is irregular, e.g. from an un-quantised MIDI file or real-time performance, then 

this method may not be wholly successful across the track, and you will have to rely on the more time-

consuming 'tapping' method (b).  

NB. At the moment there are no facilities to edit your segments, so if you get your tapping 'wrong' you 

just have to try again. In practice, it only takes two or three tries to get the segments correct - 

depending on your tapping ability of course. 

(e) Saving segments with Score 

Finally, we need to save the Score before moving on - the segments you created will be saved with it.  

• Save your Score with a new name, i.e. do 'Save As': 

Switch: Main menu (Switch 2, or Space):  File -> Save As 

Keyboard: Ctrl-shift-S 

Mouse: File menu: 'Save other' -> 'Save Score As' 
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• Give the file a new name to reflect the segments you have entered. 

When preparing material for performance, you may end up having several versions of the same score 

saved, each with different segments for a variety of users or occasions. 

6.5.7 More ways of conducting tracks 

So far, we have been performing by 'conducting tracks - by segment. As you will have seen, this 

means that each segment is 'triggered' then plays for its preset duration. For many kinds of music, or 

user, this is ideal, as you can 'fire and forget' - i.e. a simple switch click can trigger what might be a 

large musical phrase, or a note which has been preset to be long or short. However, you may want to 

have more control, or even want to require less control - and there are two other modes of conducting 

tracks which do this. 

(a) Conducting with indefinite duration 

First we will look at a mode which only lets you trigger a single note or chord each time (not longer 

phrases or segments) and sustains indefinitely until you press a switch or key again. 

This mode would be useful, for example, for players who have more difficulty pressing switches. A 

performer can trigger a note or chord (as before, using Switch 2 or Space) which will then continue 

without any further effort until the next note is wanted. This would suit pad chords or drones, or sound 

effects which could underpin other players. The notes can be silenced if desired using Switch 1 - in a 

similar way as for conducting backwards - see 6.5.3 (b). 

Before we start, you need to make sure you have selected a sustaining instrument for the track, e.g. 

trumpet, not piano, in order to hear the effect of this mode clearly. 

• Choose a sustaining instrument (e.g. press I, or see 6.4.9). 

Now set the track conducting mode to 'by note / chord - dur. Indefinite': 

• Open the track conducting mode menu: 

Switch: Open Main menu (Switch 2 or Space). Select Perform, then 

'Conducting set-up', then 'Track conducting mode'. 

Keyboard: Ctrl-P ('conducting set-up' menu) -> 'Track conducting mode' 

Mouse: 'Perform' menu:  'Conducting set-up' -> 'Track conducting mode' 

• Then select the second item:  'by note / chord - dur. Indefinite'. 

• Now start conducting (e.g. press 'A', or see 6.5.3).  

The bottom info panel should go green, and it's top line should confirm you are now conducting in this 

'dur. Indefinite' mode.   

NB. You may also see large numbers within each track; this is an option to show the number of the 

note or chord (on the left), out of the total (on the right), which is useful if you are performing a within a 

group for example, and need to know where you are in your track. 

• Press Switch 2 (or Space) to conduct, and notice each time that you are triggering the next 

note (or chord). This then sustains indefinitely until you press Switch 2 again. 

• If you used the keyboard (shortcut or menu) or mouse to start conducting, then try pressing 

Switch 1 while conducting - it will cut off any sounding notes.  

NB. If you used switches to start conducting, then Switch 1 will simply finish conducting. 
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• Press Switch 3 (or Down cursor) as before to change track. 

• Press <Enter> (or Switch 1 if switches are in use) to stop conducting, and return to normal (the 

info panel reverts to pink colour). 

(b) Conducting with gated duration 

If players are able to control how long they hold a switch down, then they can use a 'gated' conducting 

mode. In this, each note of the chord is sustained only while the switch is held down. This makes for 

more expressive playing, with more control over the musical feel and timing than the other modes - 

the start and stop of each musical event is under the performer's control. 

The PC keyboard is not suitable for this mode (as E-Scape cannot tell if a key is held down, only if 

pressed), so you can either use the mouse buttons, or (better) use MIDI notes assigned to each track 

(see 7.6). For simplicity, we will just use the mouse buttons here.  

NB. You can connect switches to act as mouse buttons, either by physically modifying a PC mouse or 

trackball, or by using a switch interface, which lets you 'press' mouse buttons. 

 

Now try conducting. Again, before you start, make sure each track has a sustaining instrument, so 

you can hear held notes clearly - see (a) above. 

Again make sure that the track conducting mode is set to 'by note / chord - dur. Gated': 

• Open the track conducting mode menu as before: 

Switch: Open Main menu (Switch 2 or Space). Select 'Perform', then 

'Conducting set-up', then 'Track conducting mode'. 

Keyboard: Ctrl-P ('conducting set-up' menu) -> 'Track conducting mode'. 

Mouse: 'Perform' menu:  'Conducting set-up' -> 'Track conducting mode'. 

• Then select the third item:  ' 'by note / chord - dur. Gated by MIDI / mouse'.  

• Press Switch 1 (Enter) to proceed from the information window which appears. 

• Now start conducting (e.g. press 'A', or see 6.5.3). The bottom info panel should go green, and 

the top line should confirm you are now conducting in this 'dur. Indefinite' mode. 

• If you try to press Switch 2 (or Space), you will get a beep - these controls are not used in this 

mode. 

• Press the left mouse button, to trigger the next note (or chord) on the current (active) track, 

which will sustain until you release the button. 

• Press the right mouse button. This will always trigger the next note (chord) on the last track. 

• Press Switch 3 (or Down cursor) as before to change track. 

• Then press the left mouse button again - the left button always triggers notes in the current 

track. 

• Press <Enter> (or Switch 1 if switches are in use) to stop conducting, and return to normal 

(info panel reverts to pink). 
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NB. Due to the way Windows works, you will get occasional false triggering if you hold (i.e. sustain) 

notes for a long time in one track while conducting many notes on another track. Using MIDI notes 

assigned to conduct each track (see 7.6) will avoid these problems. 

(c) Summary of the three track conducting modes 

i. 'by segment' 

The track is split up into segments or chunks of music, which when triggered play normally (i.e. as 

composed). 

ii. 'by note / chord (indefinite duration)' 

Each note or chord is played and sustains indefinitely until the next switch or key press (useful for 

long sustaining pads etc, for a player who can't move very fast). 

iii. 'by note / chord (gated duration)' 

Each note or chord sustains only WHILE the 'switch' is held down. This only works using MIDI notes 

assigned to each track as switches, or using mouse buttons. 

6.5.8 Recording a performance 

By default, every time you use the perform functions (e.g. track conducting), everything is recorded 

automatically. This recording also includes any performers who are playing via E-Scape using MIDI 

Thru (see 7.7). 

At any time, you can then instantly play back the last performance you did, or save it to disk quickly, 

or open it for further editing in a Score window. 

(a) Playing back the last performance 

• Play back your last performance now: 

Switch: Main menu: Perform ->  'Replay last performance' 

Keyboard: ` 

Mouse: 'Perform' menu:  'Replay last performance' 

You should now be hearing your last performance playing back, although nothing is seen. 

• If it is a long recording, you can stop play by pressing <Enter> or Switch 1 as usual, or press ` 

again. 

(b) Saving the last performance 

If you want to quickly save this to disk, to use later, you can do so. It is given a name automatically, to 

save time, e.g. in a workshop situation. If your Score is called 'MyScore', then the file will be saved to 

disk with the name 'Performance from MyScore, DATE, TIME'. The date and time allow multiple 

performances to be done and saved from the same Score, and identified later (the time includes 

seconds, in case you did further performances within the same minute!).  

NB. If you do want to specify the name, see (c) below. 

• Save your last performance now: 

Switch: Main menu: Perform ->  'Save last performance' 

Keyboard: Alt- ` 

Mouse: 'Perform' menu:  'Save last performance' 
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Typically you might save many performance 'takes' in the course of a session, and for this reason 

these Scores aren't saved into the usual 'Scores for user ***' folder, but into a separate 

'Performances' folder within your User folder. 

To check it is now saved to disk, let's open the file. As it has been saved in the 'Performances' folder 

we can’t use the normal 'Open Score' option, which just looks in your user Scores folder (to enable a 

switch user to access it via a simple list menu). Instead we need to use the 'Open Score from any 

disk' option which let's you open a Score from anywhere, via a conventional file dialog. This is only at 

present operable using the mouse, hence the option is only available in the drop down 'File' menu 

(using mouse). 

• With mouse, open the file menu, then 'Open Other' -> 'Open Score from any disk'.  

This then gives you a file dialog. Double click folder in the left panel to open them. Score files are 

listed alphabetically in the right hand panel. 

• From the right panel select the performance file you just saved: 'Performance from….' 

When the score window has opened, play it back normally (e.g. press <Enter>, or see 5.7.3) to check 

it sounds right. 

(c) Opening a Score window on the last performance 

You can achieve the same result faster by opening a score on the last performance straight away, 

without needing to save to disk first. Let's do another performance, then open it as a Score. 

• Do track conducting as before (e.g. 'A'), to record another performance, then stop to return to 

normal. 

• Play back this performance (e.g. press `, or see (a) above). 

• Now open a Score window on this performance: 

Switch: Main menu: 'Perform' -> 'Other things' ->  'Open Score (on last 

performance)' 

Keyboard: O ('Other things' menu): 'Open Score (on last performance)' 

Mouse: 'Perform' menu:  'Open Score (on last performance)' 

You can now edit, play or save this score as you wish. 
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7. User Settings 

In section 5.5 we saw that most settings are made from the Settings window, with most options also 

available from a pop-up Settings menu. 

To open the Settings window: 

 

Switch: Main menu: 'Other things' -> 'Settings' -> 'OPEN Settings Window'. 

Keyboard: Press 'S' 

Mouse: 'User/setup' menu: 'Open Settings window''. 

This getting started guide cannot cover every settings option - there are over 60 of them. We will here 

just cover those mentioned so far in this guide. 

7.1 Setting 'Duration mode'  

E-Scape can show durations in 'beat values' (assuming 4/4 time signature), or as 'note lengths' i.e. 

conventional music terms such as crotchets, quavers etc. These durations are also shown in the 

'Choose Step Length' menu - see 5.6.8, and 6.4.1(b). To set duration mode: 

 

Switch / Keyboard: Open main menu (Space or Switch 2): select 'Other things' ->  

 'Settings' ->  'Duration mode'. 

Mouse: First open the Settings window as above, then: 

Click on Scores menu, and select 'Duration mode'. 

In addition to the two options for 'beat values' or 'note lengths', there is an option to show duration as 

'Comparative'. This still displays duration in beats (e.g. in the Score window), but in the 'Choose Step 

length menu' durations are shown relative to current duration - e.g. you can choose to make the notes 

twice as long as they are at the moment, or four times as long etc. This option can be useful for real 

beginners who may have had no experience of music. 

7.2 Changing tempo 

To increase [decrease] tempo: 

 

Switch: Main menu: 'Edit' -> 'More Edit options' -> 'Increase [Decrease] tempo'. 

Keyboard: Press  shift-E ->  'Increase [Decrease] tempo'. 

Mouse: 'Score' menu: 'Choose faster [slower] tempo'. 

NB. This setting is actually saved as part of the Score, rather than saved as a user setting.  

Please note that in the present version of E-Scape, the time signature is fixed to 4/4 time, and the 

tempo is fixed and can’t change part way through the score. 

7.3 Setting the key and scale 

The scale determines which notes can be selected and transposed. The default is to have 'no key', 

i.e. a chromatic scale - with all 12 notes of the (western, equal tempered) scale available to enter - 

and notes will transpose chromatically.  

Three other scales can be selected: major, minor and pentatonic. If one of these is selected, you will 

then be prompted to choose a key for that scale. You can also change the key at any time. 
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(a) Setting the scale: 

Switch /  

Keyboard: 

Open main menu (Space or Switch 2): select 'Other things' ->  'Settings'  -> 

'Choose SCALE to compose in'. 

Mouse: First open the Settings window as above, then: 

Click on Scores menu, then select 'Choose Scale'. 

(b) Setting the Key: 

Switch /  

Keyboard: 

Open main menu (Space or Switch 2): select 'Other things' ->  'Settings'  -> 

'Choose KEY to compose in'. 

Mouse: First open the Settings window as above, then: 

Click on Scores menu, then select 'Choose Key'. 

 

7.4 Setting the 'Pitch entry mode' 

In section 6.4.2(a.iii) we looked at changing this mode, so that when using switches to 'Add a note' we 

get a menu of pitches, instead of the default 'add a note and transpose it' procedure. 

To change Pitch entry mode: 

Switch /  

Keyboard: 

Open main menu (Space or Switch 2), then select 'Other things' ->  'Settings'  -> 

'Pitch entry mode'. 

Mouse: First open the Settings window as above, then: 

Click on Scores menu, then select 'Pitch entry mode'. 

Then select either 'With pitch of PREVIOUS note' or 'Pitch chosen from menu'. The former is far 

easier for beginners, and the latter useful for users who are learning more about music theory. 

7.5 Setting the Switch 1 behaviour while conducting 

In 6.5.3(b) we saw that Switch 1 can conduct backwards, if the keyboard was used to start 

conducting. You can also set up so that Switch 1 will always conduct backwards. In this case, to finish 

conducting, you need to press Switch 3 several times - full instructions are given on screen. 

To set this: 

   Switches: Open Main menu (Switch 2 or Space), then select 'Perform' -> 'Conducting set-up' 

-> 'Switch 1 behaviour' -> 'Always conduct backwards'. 

Keyboard: Ctrl-P (to open 'Conducting set-up' menu), then select 'Switch 1 behaviour' -> 

'Always conduct backwards'. 

Mouse: 'Perform' menu: 'Conducting set-up' -> 'Switch 1 behaviour' -> 'Always conduct 

backwards'. 

7.6 Assigning MIDI notes to conduct each track 

We looked at conducting using switches 1, 2, and 3, or the keyboard. In addition, a MIDI note can be 

assigned to each track to conduct it independently. Using MIDI notes is especially useful when using 

gated mode 6.5.7(b). To assign notes: 

• From the Score window: 

  Switches: Main menu -> 'Perform' -> 'Conducting set-up' -> 'MIDI settings for conducting' -> 

'Assign MIDI notes for all tracks'. 
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Keyboard: Ctrl-P ('Conducting set-up' menu) -> 'MIDI settings for conducting' -> 'Assign MIDI 

notes for all tracks'. 

Mouse: Perform' -> 'Conducting set-up' -> 'MIDI settings for conducting' -> 'Assign MIDI 

notes for all tracks'. 

You will then be prompted to play a MIDI note, for each track. When you are conducting tracks (in any 

mode), all the other controls still work, but in addition the MIDI notes you have assigned will conduct 

each track independently at the same time. 

7.7 Turning on MIDI Thru 

Performers who are playing a MIDI instrument can feed it through E-Scape, which has two big 

advantages: (a) all players can use a single sound module connected to E-Scape and (b) their 

performance can be recorded alongside E-Scape users who are conducting (e.g. see 6.5.8). 

To switch on 'MIDI thru': 

From the Settings window: 

Switch / Keyboard: Open main menu (Space or Switch 2)  -> 'MIDI control' -> 'MIDI 

Thru' -> 'MIDI Thru ON'. 

Mouse: 'MIDI-Thru' menu -> 'Thru ON' 

By default, E-Scape will send thru all 16 MIDI channels, when switched on. 
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8. Keyboard control - Reference 

8.1 In the main window  [NB. For drop-down menu shortcuts, see 8.4] 

File 
 

F Open the 'File' pop-up menu. 

Ctrl- F Select from the Scores present windows. 

NB. This is like selecting an arrangement from the Cubase 'window' 

menu. 

Ctrl- O Open Score (from current user folder). 

Ctrl- Shift- O Open MIDI file    ** requires use of mouse ** 

Ctrl- S Save Score (into the current user folder). 

NB. Current user folder path is:  c:\Program Files\E-

Scape\Users\User - myname\Scores for user myname\ 

Ctrl- Shift- S   Save Score as...   

Ctrl -Q Quit. 

Ctrl- Shift- Q ‘Quick Quit’ (does not prompt to save). 

Selecting notes or step position 
 

L   Open the 'Locate cursor' menu. 

<left cursor> Select  the note to the LEFT of the current note. 

<right cursor> Select  the note to the RIGHT of the current note. 

Shift- <left cursor>  Select  the note to the left in ADDITION to the current note. 

Shift- <right cursor>  Select  the note to the right in ADDITION to the current note. 

Ctrl- A  Select all the notes on the page (in the current track). 

 ,  Move step cursor left by snap amount. 

 . Move step cursor right by snap amount. 

<   (English) Move step cursor left one bar. 

;         (Norwegian) Move step cursor left one bar. 

>  (English)  Move step cursor right one bar. 

:         (Norwegian) Move step cursor right one bar. 

Editing 
 

E Open 'Edit' pop-up menu. 

Shift-E Open 'More Edit options' menu. 

<Up cursor> Transpose up one semitone. 

<Down cursor> Transpose down one semitone. 

Shift- <Up cursor> Transpose up - selecting interval from menu. 
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Shift- <Down cursor> Transpose down - selecting interval from menu. 

V Increase loudness - selecting amount from menu. 

Shift- V Decrease loudness - selecting amount from menu. 

Ctrl- <Left cursor> Move notes left by snap. 

Ctrl- Shift- <Left cursor> Move notes to next bar left. 

Ctrl- <Right cursor> Move notes right by snap. 

Ctrl- Shift- <Right cursor> Move notes to next bar right. 

M Open the 'Move notes' menu. 

Ctrl- X   or <F2> Cut notes. 

Ctrl- C   or <F3> Copy notes. 

Ctrl- V  or <F4> Paste notes (merge). 

Ctrl- Shift- V   [or shift- F4] Paste notes (merge) - selecting from menu of clippings.  

I Change instrument for the current track. 

Shift- I Change the XG instrument bank for current track. 

Alt- Q ‘Quantise’ the start time of selected notes (to current snap value). 

Alt- Shift- C Change MIDI channel of selected notes. 

Ctrl- Shift- D Open 'Delete Controllers' menu.                 [for more advanced users] 

Playing 
 

Enter Play the score (all tracks), on the current page. 

Enter, Esc  [when Playing ] Stop play. 

# Play the current track, on the current page. 

Shift- P Play the current track, from the start of the score. 

Shift- S Play the selected notes in current track. 

X Play the selected notes in context. 

 [i.e. play other notes before and after]. 

Shift- X Play the selected notes in context, just in current track. 

T Mute / unmute current track. 

Esc  or  0  or   ' Kill MIDI notes. 

Entering notes 
 

N Open the 'Enter notes' pop-up menu. 

K Add new note - choosing pitch from menu. 

+ Add a new note (with current duration at current step position). 

= Add a new note (as above), then do audition and transpose routine. 

-  Add a 'rest'  (with current duration). 

<delete>  Delete the selected notes. 

D Open the 'Step Duration' menu. 

Alt- 1 Select step duration of 4 beats (Semibreve). 
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Alt - 2 Select step duration of 2 beats (Minim). 

Alt - 3 Select step duration of 1 beat (Crotchet). 

Alt - 4 Select step duration of 1/2 beat  (Quaver). 

Alt - 5 Select step duration of 1/4 beat  (Semiquaver). 

Alt - 6 Select step duration of 1/8 beat  (Demisemiquaver). 

Alt - 7 Select step duration of 3 beats   (Dotted minim). 

Alt - 8 Select step duration of 1-1/2 beats  (Dotted crotchet). 

Alt - 9 Select step duration of 3/4 beat   (Dotted quaver). 

NB. 1, 2 & 3 are used for switch interfaces (emulating the keyboard). 

Alt-R Start MIDI real-time record. 

R       [or Alt-shift-R] Turn ‘MIDI Step Record’ mode on / off. 

Performing 
 

P Open 'Perform' pop-up menu. 

Ctrl- P Open 'Conducting Settings' menu. 

A Start Track conducting. 

shift- A Start Score conducting. 

` Play last performance.                      [and stop] 

Alt - `  Save last performance (with auto naming). 

Ctrl- T Create segments by tapping. 

Q Create segments using duration of selected note(s). 

Window 
NB. The usual MS Windows Alt-F4 also works. 

W Open the 'Window' menu. 

Ctrl- W Close the score window (will prompt to save). 

[    (English version) Scroll left half a page.   

<        (Norwegian version) Scroll left half a page. 

]    (English version) Scroll right half a page.   

>        (Norwegian version) Scroll right half a page. 

  

Shift- [  Scroll left one page.   ** Not available in Norwegian version ** 

Shift- ]  Scroll right one page. ** Not available in Norwegian version ** 

<Home> Scroll to first page. 

Z Zoom time IN x2. 

Alt- Z Zoom in variable amount (via menu) 

Shift- Z Zoom time OUT x2. 

Alt- Shift- Z Zoom out variable amount (via menu) 

<Page up>  Make active the track above.  

<Page down>   Make active the track below.  
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Utilities 
 

S Open or close the Settings window. 

O Open the 'Other things' menu. 

U Open the ‘Utilities’ menu. 

Shift- N Rename the current track. 

Alt- Shift- N Rename the Score 

Ctrl- Shift- T Open notepad for the Score. 

Shift- B Switch bar / beat line display on or off. 

<F11> Play the next note or chord in current track. 

8.2 Opening pop-up menus 

F Open File menu. 

E Open Edit menu. 

Shift-E Open 'More Edit options' menu. 

C Open Copy menu. 

M Open 'Move notes' menu. 

L Open 'Locate cursor' menu. 

N Open 'Enter notes' menu. 

P Open Perform menu. 

W Open Window menu. 

O Open 'Other things' menu. 

U Open Utilities menu. 

8.3 Operating pop-up menus 

<Space>    (if using 'two switches') Scroll down one item.  

<Space>    (if using 'single switch') Select item.      [or Switch 1] 

<Enter> Select item. 

<Down cursor>       [or Switch 2] Scroll down one item. 

<Up cursor>            [or Switch 3] Scroll up one item. 

<Left cursor> Scroll down three items. 

<Right cursor> Scroll up three items. 

<Esc> Cancel menu. 

8.4 Opening drop-down menus  

Alt-F Open File menu. 

Alt-E Open Edit menu. 

Alt-Y Open Play menu. 

Alt-N Open Note entry menu. 

Alt-P Open Perform menu. 



E-Scape: Getting Started Guide   © Inclusive Music, 2008                                                            89

Alt-S Open Score menu. 

Alt-T Open Track menu. 

Alt-W Open Window menu. 

Alt-U Open 'User / settings' menu. 

8.5 While doing MIDI step entry  (bottom panel goes red) 

<Space> Add 'rest'   (i.e. move step cursor by step duration). 

8.6 While conducting  (bottom panel goes green) 

Alt- Shift- 1 Reset track 1 to the beginning. 

Alt- Shift- 2 Reset track 2 to the beginning. 

…. …. 

Alt- Shift- 9 Reset track 9 to the beginning. 

Alt- Shift- 0 Reset track 10 to the beginning. 

  

F1 / Shift- F1 ‘Pause’ / ‘Un-pause conducting for track 1. 

F2 / Shift- F2 ‘Pause’ / ‘Un-pause conducting for track 2. 

…. …. 

F9 / Shift- F9 ‘Pause’ / ‘Un-pause conducting for track 9. 

F10 / Shift- F10 ‘Pause’ / ‘Un-pause conducting for track 10. 

F12 / Shift- F12 Pause / Un-pause ALL tracks (up to a maximum of 10). 

  

Alt- <Left cursor> Selects previous segment in the current track, without playing it. 

Alt- <Right cursor> Selects next segment in the current track, without playing it. 

Alt- 1  Selects the previous segment, without playing it, for track 1. 

Alt- 2 Selects the previous segment, without playing it, for track 2. 

… … 

Alt- 9 Selects the previous segment, without playing it, for track 9. 

Alt- 0 Selects the previous segment, without playing it, for track 10. 

  

T Kill (turn notes off) on any MIDI Thru channels received. 

' Kill just the MIDI channels used by current Score. 

@ Kill Thru channels received AND Score channels used (i.e. both the 

above). 

K Kill all MIDI Thru and output channels set to be used. 

shift- K Kill all MIDI Thru and output channels as above, then reset MIDI and 

clear memory (only for major problems!). 

----- END ----- 

 


